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Important safety instructions

• Read the instructions.
• Keep these instructions.
• Follow all instructions.
• Do not use this apparatus near water.
• Clean only with a dry cloth.
• Install only in accordance with the manufacturer’s instructions.
• Only use with a Meridian 861 Reference Digital Surround Controller.
• Refer all servicing to approved service personnel.
• Connection to the mains should be carried out by a skilled and suitable 

qualifi ed person.

Safety warnings

WARNING: TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT 
EXPOSE THIS APPARATUS TO RAIN OR MOISTURE

• Do not expose the unit to dripping or splashing.
• Do not place any object fi lled with liquid, such as a vase, on the unit.
• Do not place naked fl ame sources, such as lighted candles, on the unit.

To avoid overheating

Do not position the unit:

• In direct sunlight.
• Near heat sources, such as a radiator.
• Directly on top of heat producing equipment, such as a power amplifi er.

To avoid interference

Do not position the unit:

• Near strong electrical or magnetic radiation, such as near a power 
amplifi er.
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Radio interference

FCC Warning: This equipment generates and can radiate radio frequency 
energy and if not installed and used correctly in accordance with our 
instructions may cause interference to radio communications or radio and 
television reception. It has been type-tested and complies with the limits set 
out in Subpart J, Part 15 of FCC rules for a Class B computing device. These 
limits are intended to provide reasonable protection against such 
interference in home installations.

EEC: This product has been designed and type-tested to comply with the 
limits set out in EN55013 and EN55020.
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Introduction

Welcome to the Meridian 861 Reference Digital Surround Controller!

This User Guide provides full information about using the surround 

controller in conjunction with your other equipment, to achieve the 

superb results you can expect from it.
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INTRODUCTION

The 861 Reference Digital Surround 
Controller

 Digital signal processing, or  DSP, is a technique pioneered by Meridian in 
hi-fi  products for achieving extremely accurate reproduction of audio 
signals. Unlike conventional analogue systems – which process signals using 
electronic circuits based on resistors, capacitors, and inductors – DSP works 
by performing exact mathematical calculations on digital versions of the 
signals.

The advantage of DSP over analogue circuitry is that the signals are held as 
precise numbers, rather than voltages in a circuit. This means that any 
number of stages of processing can be performed with high precision, and 
without any of the cumulative noise or degradation that inevitably occurs, 
even with high-quality analogue circuitry. In addition, several of the 
surround-sound decoding techniques and signal improvement techniques 
available in the 861 would be virtually impossible to implement in 
analogue circuitry.

At Meridian we have taken advantage of the availability of high speed DSP 
microprocessors to incorporate DSP in hi-fi  products, and the 861 is the 
result of over a decade of our research and development in this fi eld.

The 861 takes advantage of DSP for several different functions:

• To de-jitter incoming digital signals and expand the precision of the 
signal.

• To perform fi ltering or adjustment of the frequency response; eg treble 
or bass.

• To decode digitally-encoded signals from Dolby Digital (AC-3), DTS, or 
MPEG Audio.

• To process the audio into a multi-channel signal, and match the source 
channels to the confi guration of main loudspeakers and subwoofers in 
the system.

The 861 converts analogue input signals to digital format, using high-
quality analogue-to-digital converters (ADCs). Digital signals, from CD, 
DVD, LaserDisc or digital broadcasting, are already in digital format and do 
not need to be converted.

The signals are then retained in digital form throughout the 861 until they 
are converted back to analogue form at the analogue outputs, to drive 
power amplifi ers. If you are using the 861 with Meridian DSP Loudspeakers, 
the signals remain in digital form until the last possible stage.
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 Format decoding, DSP presets, and 
layouts

The 861 provides an extensive range of options for decoding and 
processing analogue and digital signals for multi-channel reproduction.

The formats processed by the 861 can be divided into the following 
categories:

• Discrete multi-channel.
• Encoded multi-channel.
• Encoded two-channel.
• Conventional stereo.

Encoded multi-channel formats

   Dolby Digital
Dolby Digital, previously called   AC-3, is the preferred sound format for 
DVD, and is widely used on NTSC LaserDisc soundtracks. It is also the audio 
standard for US digital television.

   DTS
DTS uses an audio compression technique to encode fi ve channels of audio 
onto a digital signal. The DTS format is used to encode multi-channel fi lm 
soundtracks on LaserDiscs and DVD-Video discs. DTS can also be used to 
compress 5.1 channels of high-quality audio into the same space as two 
channels of unencoded sound, to provide 5-channel music CDs.

   MPEG
MPEG Surround is an alternative to Dolby Digital, used to encode multi-
channel soundtracks on DVD-Video.

When the 861 detects the input format it automatically decodes it for the 
appropriate number of speakers. It then allows you to apply a range of 
signal processing options, called DSP presets. These provide effects such as:

• Creating additional channels to enhance the surround effect.
• Controlling the width and depth of the image.
• Adjusting the tonal balance of the sound.

The presets available for each audio format are described in the following 
sections.
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Two-channel presets

Direct
Uses only the left and right speakers, bypassing spatial processing. Tone 
controls and speaker protection still operate. 

Music
Extracts the mono and surround components of the original recording. The 
mono element is equalised to match the tone colour of the centre speaker. 

Trifi eld
Similar to Music, but gives a more focused front stereo image and allows 
the width of the image to be adjusted. 

Ambisonics
Decodes stereo-UHJ Ambisonics recordings to produce a realistic soundfi eld 
at the listening position. 

Super
A variation of Ambisonics that has been optimised to work with unencoded 
stereo material. Particularly effective on recordings that have been made 
using true coincident microphones.

Stereo
Applies bass management to the left and right speakers. No spatial 
processing is performed. 

MusicLogic
A music DSP preset based on the ProLogic II processing mode with the 
addition of user-adjustable steering, designed to provide an exciting 
experience with many types of studio-produced music. 

Mono
Enables listening to only one of two input channels, such as when different 
languages or material are carried on each channel, or a combined version 
of the two channels when a mono recording is conveyed on a two-channel 
carrier.

TV Logic
A movie preset based on the ProLogic II processing mode with the addition 
of user-adjustable steering, designed to give higher intelligibility and a 
more appropriate spatial presentation for studio-based TV material. 

PLII Music
Designed to use the Pro Logic II processing mode to decode music sources. 
It provides additional Width, Dimension, and Panorama preset 
parameters to allow you to adjust the soundfi eld. 
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PLII Movie
Uses the Dolby Pro Logic II processing mode, and is the recommended 
choice for Dolby Surround encoded material. 

PLII THX
Provides additional signal processing refi nements developed by Lucasfi lm 
Ltd. designed to provide a better match between the sound of the movie 
theatre and a home cinema.

Multi-channel presets

Discrete
A multi-channel preset to be used when no further processing is required. 
Uses the Music speaker layout. 

Cinema
Similar to Direct, but uses the 5.1 Movie speaker layout.

EX
Allows 5.1-channel fi lm soundtracks to be encoded with an extra surround 
channel to give improved surround imaging with four surround speakers. 

EZ
A Meridian variation of EX processing with the addition of user-adjustable 
steering. 

THX
Provides additional signal processing refi nements developed by Lucasfi lm 
Ltd. designed to provide a better match between the sound of the movie 
theatre and a home cinema. 

THX EX
A combination of THX fi ltering and EX spatial processing. 

THX Ultra2
Uses a THX proprietary process to create four surround channels from a 
5.1-channel fi lm soundtrack. 

THX Music
Uses a similar processing technique to THX Ultra2, but optimised for music 
reproduction. 

Ambisonics
Decodes multi-channel B format Ambisonics recordings to produce a 
realistic soundfi eld at the listening position. Ambisonics is only available on 
multi-channel PCM input, such as from DVD-A.
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  Layouts

The 861 allows you to defi ne three different speaker layouts, called Music, 
Logic, and 5.1 Movie, optimised for different types of preset. The layout 
used for each preset is shown in the following table:

Layout DSP presets

Music
Direct, Music, Trifi eld, Ambisonics, SuperStereo, Stereo, PLII Music, 
Discrete, THX Music

Logic MusicLogic, Mono, TV Logic, PLII Movie, PLII THX 

5.1 Movie Cinema, EZ, EX, THX, THX EX, THX Ultra II
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Overview

The architecture of the 861 allows for wide fl exibility – future sources and 
formats can be handled by upgrading either software or cards.

 Meridian MHR Smartlink

The 861 Reference Digital Surround Controller incorporates a unique multi-
channel link, which allows it to receive an upsampled 6-channel PCM 
stream from a compatible source, such as the Meridian 800 Reference 
DVD / CD Player, for the highest possible sound quality.

An additional feature of the Meridian MHR Smartlink is that it obtains 
intelligent stream content information from the source, allowing the 861 
Reference Digital Surround Controller to select an appropriate preset 
depending on whether the source is music or a movie soundtrack, and 
whether it is 2-channel or multi-channel. 

Inputs

The 861 is a full-system controller preamp that provides seamless control of 
up to 12 sources.

The optional Tape card provides additional A/D and D/A converters to give 
support for both tape recorders, extensive 2- and 3-zone multi-room 
capability (analogue or digital formats), and headphones.

By providing digital as well as analogue inputs the 861 can give radically 
higher sound quality for sources that are originally digital – like CD, 
LaserDisc, Digital Radio and DVD.

As well as accepting 2-channel digital audio, the 861 will handle SPDIF-
encoded Dolby Digital, DTS or MPEG from sources like DVD, Satellite and 
LaserDisc (via an RF00 LaserDisc Demodulator Card).

Processing

The Meridian 861 routes all signals – if necessary via a 24-bit A/D converter 
– into the digital domain for processing in the highly developed Meridian 
24-bit DSP cards.

The incoming signals are processed using a variety of proprietary 
algorithms, and up to eight output signals are generated. These output 
signals can be used to feed a number of speaker layouts, ranging from two 
to seven speakers with up to eight Meridian digital subwoofers.

The on-board algorithms include Meridian’s own highly transparent Dolby 
Pro Logic, PLII, Dolby Digital, MPEG Surround, DTS, THX extensions, TV 
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Logic, and a variety of award-winning music programs including Trifi eld 
and Ambisonic.

Outputs

The 8+ outputs can be provided as digital signals to feed Meridian DSP 
Loudspeakers, or as variable analogue outputs using a proprietary 
on-board 24-bit resolution conversion method.

Video control and OSD

The Meridian 861 provides broadcast-grade video switching options for 
monitors, projectors and video tape routing. The comprehensive set-up and 
customising facilities allow the user to link any video and audio 
combinations to the 12 sources (accessed from the Source key on the front 
panel or the remote control).

In addition to providing high-quality video buffering, the 861 has the 
ability to give help and system control feedback information in an 
on-screen display. Video formats supported include Composite, S, and 
Component.
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Typical  specification

Audio in and out 

• Up to 12 analogue inputs. User-adjustable sensitivity. Re-nameable 
legends. 

• Up to 12 digital inputs. Re-nameable legends. 32 to 96kHz sampling, and 
up to 24-bit precision. 

• Digital and analogue tape loops. 
• Independent copy and 2-room+ capability. 
• Up to 10 digital outputs. 
• Up to 10 analogue outputs.
• Optional 5.1-channel analogue input.

Control signals

• 3 trigger outputs, programmable by source.
• Meridian Comms and RS232 for control and setup.

Controls, etc.

Front-panel facia controls for: 

• Source, DSP, Mute, Volume, and Off.

Hinged control panel provides additional switches for: 

• Display, Copy, Store, parameter menus, Assign, Calibrate, and Confi gure. 

Display 

• 20-character dot-matrix display: adjustable brightness and contrast. 
• Lights for Dolby, Digital, THX, DTS, and MPEG.
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Using the 861 Reference Digital Surround 

Controller

This chapter provides a summary of the functions of the 861 Reference 

Digital Surround Controller to identify the controls which you use to 

operate the unit. 

It also provides step-by-step instructions for operating the digital 

surround controller, using either the front panel or the Meridian 

System Remote.
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 Front panel keys
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Meridian  System 

 Remote keys

Menu keys
Allow you to select 
DSP parameters 
and change their 
values

Top Menu/#TT
For controlling a
DVD player

DSP
Changes the DSP
preset

Store/Clear
For programming 
DSP presets

Display
Changes the
front-panel 
display

Control keys
For controlling a 
CD player, DVDrr
player, or tunerrr

Number keys
For controlling a 
CD player, DVDrr
player, or tunerrr

Function
Hold down to
select a secondary
function, shown in 
blue below some
keys

Volume keys/MuteVV
Change the volume

Off
Switches all
Meridian equipment
to standby

Source keys
Select a source
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 Switching on and off

When not playing, the digital surround controller should be left in the 
standby state. This ensures that the components of the digital surround 
controller operate at maximum effi ciency from the moment you start.

If you are not going to use the digital surround controller for several days 
you should switch the unit off completely at the rear panel, and disconnect 
it from the AC power supply.

To switch on from standby

•   Press Source (front panel), or select a source by pressing the appropriate 
source key on the remote; eg CD.

If the digital surround controller is part of a Meridian system it will 
automatically switch on any other unit in the system, such as the 800 
Reference DVD/CD Player and Meridian DSP Loudspeakers.

To switch to  standby

•   Press Off (front panel or remote).

If you have other Meridian equipment or Meridian DSP Loudspeakers 
connected to the digital surround controller these units will also switch to 
standby.
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Your installer may have 

customised the labels displayed 

for each source to suit your other 

equipment.

Selecting a  source

The digital surround controller provides the following 12  sources:

CD, Radio, DVD-A, TV, Tape 1, Tape 2, CDR, Cable, DVD, VCR1, VCR2, LDisc.

The input and DSP preset associated with each source 
depends on how the digital surround controller has been 
set up; for more information see Setting up sources, 
page 78.

To select a source

•   Press Source (front panel) until the display shows the source you 
require, or press the appropriate source key on the remote; eg CD.

The display shows the source, DSP preset, and volume setting. 

For example, if you select the CD 
source the display might show:                    CD    Trifield    65

The digital 

surround controller mutes the 

sound while you change source, to avoid 

clicks in the speakers.
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Adjusting the  volume

The 861 Reference Digital Surround Controller adjusts the volume in precise 
steps of 1dB, where 9dB is equivalent to doubling the loudness. The current 
volume setting is displayed in dB on the front-panel display, and can be 

varied in the range 1 to 99dB. When you fi rst connect power 
to the digital surround controller the volume is set to 65, 
which is similar to the mid-way position of the rotary 
volume control on a conventional preamplifi er.

For normal to high level listening you should expect to use 
volume levels in the range 60 to 90.

The volume on startup can be set in the advanced setup options; see To 
change the advanced setup options, page 91.

To change the volume

•   Press A or V (front panel), or the red A or V keys on the remote.

As you adjust the volume setting the display shows the current volume 
level. 

For example:                                                  CD   Trifield     70

To  mute the sound

•   Press Mute (front panel or remote). 

The display will show:                                   Mute

To restore the sound

•   Press Mute again. 

Alternatively, the sound will be restored if you adjust the volume.

A setting of 

87 corresponds to THX 

reference gain, the level at which fi lm 

soundtracks are mixed.
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Changing the  DSP preset

Each source has a set of DSP presets associated with it, one for each of the 
alternative  content types:   Music 2 (2-channel music),   Music 6 (multi-channel 
music),   Movie 2 (2-channel movie soundtrack), or   Movie 6 (multi-channel 
movie soundtrack).

When you choose a source, a DSP preset is selected depending on the 
incoming content type.

For example, if you have selected the CD source and are playing a 
conventional CD, the Trifi eld DSP preset will initially be selected.

You may then wish to choose a different DSP preset, such as Music or 
Ambisonics.

You can also change the  default DSP preset assigned to the source; see To 
assign a DSP preset to a source, page 34.

The sequence of DSP presets for each content type is as follows:

Content type Presets available

Music 2, Movie 2 Direct, Music, Trifi eld, Ambisonics, Super, Stereo, MusicLogic, Mono, 
TV Logic, PLII Music, PLII Movie, PLII THX.

Music 6, Movie 6 Ambisonics, Discrete, Cinema, EZ, EX, THX, THX EX, THX Ultra2, THX 
Music.

In each case these will be followed by any user-defi ned presets you have 
stored for the appropriate content type.

To change the  DSP preset

•   Press DSP (front panel or remote) to step between the different DSP 
presets.

You will be able to choose any of the predefi ned DSP presets, or any user-
defi ned presets you have stored.

The digital surround 

controller mutes the sound 

while you change DSP preset, 

to avoid clicks in the speakers.
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Changing the display

The 861 Reference Digital Surround Controller displays information about 
the current settings on the 20-character front-panel display. In addition, it 
can display the same information superimposed on a video image.

You can adjust the   contrast and   brightness of the front-panel display for 
optimum viewing, and choose what information is displayed.

The digital surround controller automatically stores these settings, even 
with the power off.

To  change the contrast

•   Press > or < (remote), or the corresponding menu keys under the front 
panel, until the display shows the current contrast setting.

For example: CD    Contrast   8

•   Press A or V (remote), or the corresponding menu keys under the front 
panel, to change the display contrast.

You can change the contrast between 0 and 15.

To  change the brightness

•   Press > or < (remote), or the corresponding menu keys under the front 
panel, until the display shows the current brightness setting.

For example: CD    Bright    11

•   Press A or V (remote), or the corresponding menu keys under the front 
panel, to change the display brightness.

You can change the brightness between 0 and 15.
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To change the displayed  information

•   Press Display.   TV    ProLogic

Each time you press Display the display will step between the options 
shown in the following table.

Display option Example

Source, DSP preset, and volume.  DVD-A Ambisonics  65

Source, DSP preset, and THX reference 
level.  DVD-A Ambisonics -22

Audio format, number of channels, 
sampling rate, and  content type.  DVD-A PCM Music6 44k

Blank.

If your digital surround controller is fi tted with a video card, the same 
information can be displayed on an   on-screen display.

For example:

 

You can choose the position of the  on-screen display; see To change the 
position of the on-screen display, page 33.

If the Diagnostic display option has been selected additional diagnostic 
displays are included; refer to the Meridian Web site at
www.meridian-audio.com for details.
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In addition, the following symbols on the front-panel display indicate 
which of the DSP processing modes are operating, or what the original 
format was if received via the Meridian MHR Smartlink:

Symbol What it means

 Dolby processing is operating.

DIGITAL Input is Dolby Digital.

 THX processing is operating.

 Input is DTS.

MPEG Input is MPEG
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Recording a  source

The 861 Reference Digital Surround Controller allows you to copy any of 
the standard sources to the tape outputs, independently of the source you 
are listening to.

If you are using the digital surround controller in a two-room system, you 
copy a source to the tape output to make it available to the second room.

To copy a source

•   Press Copy (remote or under the front panel).

Each time you press Copy the digital surround controller will step between 
the options shown in the table below.

For example, to   record the DVD sound on a tape recorder:

•   Press Copy until the display shows: Copy DVD

You can now listen to a different source, such as CD, by selecting the 
source, without affecting what is being recorded.

Display Option

 Copy Source
The current audio and video inputs are fed to 
the tape/VCR outputs. 

 Copy Mute
The tape and VCR outputs are muted.

 Copy CD
Copies the fi rst source to the tape and VCR 
outputs.

 Copy Radio
Steps through each source in turn, etc.

To change the  headphone  volume 

You can connect headphones to the digital surround controller using the 
optional   Tape expansion card. The source copied to the tape output is also 
fed to the headphones.

To change the headphone volume:

•   Press Function with the red A or V keys on the remote.

The display will show the current 
headphone volume; for example:                Headphone Volume 65
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Customising the 861 Reference Digital 

Surround Controller

In addition to being able to change the source, volume, and DSP 

preset, the 861 Reference Digital Surround Controller provides a 

sophisticated range of more advanced adjustments for each DSP 

preset, to allow you to tailor the sound. 

This chapter explains how to change these parameters, using the 

menu keys on the remote or under the front panel, and gives detailed 

instructions for adjusting common parameters.

For information about the parameters specifi c to individual presets see 

DSP presets, page 37.
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CUSTOMISING THE 861 
REFERENCE DIGITAL 

SURROUND CONTROLLER Locking and unlocking the menus

To simplify the normal operation of the digital surround controller, and to 
protect the settings from accidental changes, you can lock the menus so 
that the DSP parameters cannot be accessed.

The only parameters available with the menus locked are Brightness and 
Contrast.

To display or change the DSP presets, or to defi ne your own presets, you 
fi rst need to unlock the digital surround controller menus.

To  unlock the menus

•   Press Off (front panel or remote) to put the digital surround controller 
in standby. 

•   Press and hold down the Store button under the front panel for a few 
seconds.

The display shows:   Unlocked

To   lock the menus

•   Repeat the above sequence so that
the display shows: Locked
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CUSTOMISING THE 861 
REFERENCE DIGITAL 

SURROUND CONTROLLER Changing the  DSP parameters

Each DSP preset provides a series of parameters that you can vary to 
customise the behaviour of the preset to your specifi c requirements. For 
example, most presets provide Balance and Depth parameters to allow 
you to alter the characteristics of the sound.

For each of the built-in DSP presets these parameters are set to standard 
values, designed to give the best sound in typical listening conditions and 
with most source materials. Each time you select a different DSP preset the 
parameters are reset to these standard values, even if you have previously 
altered them.

You can save the changes you have made to one or more DSP parameters 
in place of the original DSP preset. Alternatively you can create a new user-
defi ned DSP preset, with a name of your choice. User-defi ned presets 
appear in the list of DSP presets after the built-in ones. For more 
information about doing this see Defi ning your own presets, page 35.

Global parameters

All DSP presets allow you to change the following global parameters, that 
affect all DSP presets:

Parameter Options Default What it changes

 Phase + or - + The phase of all loudspeakers.

 Contrast 0 to 15 10 The front-panel display contrast.

 Bright 0 to 15 10 The front-panel display brightness.

 OSD Off, Low, Med, High Low The position of the on-screen display.
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All DSP presets (except Mono, Stereo, and Direct) provide these parameters:

Parameter Options Default What it changes

 Treble -10dB to +10dB +0.0dB The slope of the frequency response.

 Bass -5dB to +5dB +0.0dB The bass response.

 Phase + or - + The absolute phase.

 Axis* -2 to +3 -1  The vertical balance.

 Balance <10 to 10> <0> The L-R balance.

 HS Out?* Y or N Y Select Y for high-rate audio, upsampled 
if necessary. Select N for standard-rate 
audio, downsampled if necessary.

 Centre -3.0dB to +3.0dB +0.0dB The level of the centre.

 Depth -2.5ms to +5ms +0.0 The relative delay of the centre.

 Rear -30dB to +10dB +0dB The relative level of the rears.

 Sides -30dB to +10dB +0dB The relative level of the sides.

 R Delay 0ms to 30ms† 0.0 The relative delay of the rears.

 S Delay 0ms to 30ms† 0.0 The relative delay of the sides.

 LipSync 0ms to 30ms 0.0 The sync. delay.

* Only available with compatible hardware; contact your Meridian dealer.
† Certain presets may have a reduced range.

Individual DSP presets provide additional parameters, to allow you to 
adjust specifi c features provided by that preset. For full details refer to DSP 
presets, page 37.

Note: Parameters not relevant to your confi guration, such as Sides in a 
fi ve-speaker system, are omitted from the sequence of menus.

To change a  DSP parameter

•   Make sure the menus are unlocked; see To unlock the menus, page 24. 

•   Press > or < (remote or under the front panel) until the display shows 
the name of the parameter you want to change. 

For example:                                                  CD    Depth   +0.0

•   Press A or V (remote or under the front panel) to change the value of 
the parameter. 
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and the display will show the current value. After a short delay the display 
will revert to the normal display of DSP preset and volume.
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The digital surround controller provides sophisticated treble and bass 
controls, to allow you to adjust the broad balance of the system to correct 
for the acoustics of your listening room, or for a misbalanced recording. 

The controls are more subtle than conventional tone controls, and take 
advantage of digital signal processing techniques to provide a more natural 

adjustment of the frequency response. 

You can also change the absolute phase of the signal, to 
compensate for recordings which are out of phase. 

In each case all the outputs of the digital surround controller are 
given the same frequency adjustment, to ensure a correct surround effect. 

To  change the  treble

•   Press < or > until the display shows the current treble setting.

For example: CD    Treble  +0.0

•   Press A or V to change the treble.

The treble control tilts the frequency of the response over the entire 
frequency range to make the sound more or less bright. It can be adjusted 
between ±10dB in 0.5dB steps. Normally settings between +1.0 and -2.0 will 
give the most natural results.

To  change the  bass

•   Press < or > until the display shows the current bass setting.

For example: CD    Bass    +0.0

•   Press A or V to change the bass.

The bass control allows you to adjust the bass response in the room by 
±5dB in 0.5dB steps. Normally settings between +3.0 and -2.0 will give the 
most natural results.

To  change the absolute  phase

•   Press > or < until the display shows the current phase.

For example: CD    +  Phase

•   Press A or V to change the phase.

If you have a 

Meridian DSP Loudspeaker 

the Treble and Bass settings 

apply to all DSP presets.
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A conventional stereo system provides a single balance control, which 
changes the relative loudness of the two speakers. The 861 Reference 
Digital Surround Controller provides a more sophisticated adjustment 
which corresponds to moving the listening position to the left or right.

The axis control allows you to adjust the optimum listening height of the 
loudspeakers, like a balance control operating in the vertical plane. This 
option is only available with Meridian DSP loudspeakers.

You can also change the level of the centre, side, and rear loudspeakers 
relative to the main speakers.

To move the listening position to the left or right

•   Press < or > until the display shows: CD    Balance  <0>  

•   Press A or V to move the listening position.

The display shows the direction and position of the listening position.

For example:                                                  CD    Balance  <3  

The arrow indicates the direction, and the number indicates the position 
where 0 is central, 8 is in line with the corresponding main speaker, and 10 
is fully to one side.

Note: This adjustment is not available for the Mono preset.

To change the axis

•   Press < or > until the display shows the current axis setting.

For example:                                                  CD    Axis      -1

•   Press A or V to change the axis.

The axis can be adjusted between -2 and +3, where 0 corresponds to the 
axis of the treble unit. Usually a listener will be below that position, so we 
recommend settings of -1 or -2.
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loudspeakers

•   Press < or > until the display shows the speakers you want
to adjust.

For example: CD    Rear    +0dB  

•   Use A or V to change the relative level of the speakers, in dB.

You can change the relative loudness of the rear loudspeakers from -30dB 
(about one-eighth of the loudness) to +10dB (about double the loudness).

For example, to double the loudness of the loudspeakers:

•   Adjust their level until the display 
shows: CD    Rear   +10dB

Note: This adjustment is not available for the Direct, Stereo, or Mono 
presets.
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centre

If you have a centre loudspeaker you can adjust its relative loudness, to 
provide the best integration of the centre with the main left and right 
speakers.

You can also adjust the relative delay of the centre speaker to give the best 
perspective between the three front speakers.

Note: These adjustments are not available for the Direct, Stereo, or 
Mono presets.

To change the relative level of the  centre speaker

•   Press > or < until the display shows the current centre level.

For example: CD    Centre+0.0dB

•   Press A or V to change the relative level of the centre speaker. 

You can change the relative level by ±3dB.

To change the relative delay of the  centre speaker

•   Press < or > until the display shows the current centre depth.

For example: CD    Depth   +0.0

•   Press A or V to change the relative depth of the centre speaker.

You can change the depth between -2.5ms, which corresponds to moving 
the centre speaker 7.5m (2 ��  feet) nearer to the listening position, and 
+5ms, which corresponds to moving it 15m (5 feet) further away from the 
listening position.

Increasing the depth 

makes the sound more open. 

Decreasing it makes the sound more 

focused.
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sound

You can adjust the spaciousness of the sound by altering the delay on the 
rear and side channels.

Note: These adjustments are not available for the Direct, Stereo, or 
Mono presets.

To change the relative delay of the  rear or  side 
speakers

•   Press > or < until the display shows: CD    R Delay  0.0

•   Press A or V to change the relative delay of the rear speakers.

Increasing the delay by 1ms is equivalent to moving the speaker 0.3m (1') 
further away.

If you have side speakers an additional  S Delay option allows you to adjust 
the delay on the side speakers.

For best results 

you should never set the 

S Delay to be less than the 

R Delay.
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display

To adjust the  lip sync

The LipSync parameter is a feature originated by Meridian that allows you 
to adjust the delay between the sound and the video image by up to one 
video frame.

Most movies are mixed for a viewing distance of 90m (30 feet), and when 
viewed from 36m (12 feet) or less the sound arrives too early, giving a 
disconcerting effect. Using the LipSync parameter you can add an overall 
delay to the sound to accommodate your closer home viewing distance.

Many TV broadcasts delay the picture by half a frame, and can benefi t from 
a LipSync setting of 12ms.

•   Press > or < until the display shows: CD    LipSync  0.0  

•   Press A or V to change the delay in milliseconds.

You can adjust the delay between 0 and 30ms, where 30ms corresponds to 
sitting 90m (30 feet) further away from the screen.

To change the position of the  on-screen display

For each DSP preset you can specify the position of the on-screen display 
(OSD), or blank the on-screen display altogether.

For example, you may prefer to have the on-screen display at the top of the 
screen when watching videos, but at the bottom of the screen when 
listening to music.

•   Press > or < until the display shows the current OSD position. 

For example:                                                  CD    OSD      Low

•   Press A or V to change the position.

You can choose between Off, Low, Med, or High.
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source

Each source has an appropriate DSP preset associated with it for each music 
format. For example, for a standard stereo (PCM) signal the CD source uses 
Trifi eld and the TV source uses TV Logic.

This section explains how to change the DSP preset associated with any 
source. 

To assign a   DSP preset to a source 

•   Make sure the menus are unlocked; see To unlock the menus, page 24.

•   Select the source you want to change by pressing the Source key on the 
front panel or the appropriate source button on the remote, eg CD.

•   If necessary, select a signal in the appropriate format. For example, to 
change the DSP preset used for DTS compact discs, play a DTS CD.

The display will show the source and the DSP preset currently assigned to 
that source.

For example:                                                  CD    Trifield    65

•   Press A or V until the display shows the new DSP preset you want to 
assign. 

For example:                                                  CD    MusicLogic  65

•   Press Assign to save the new assignment.
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The 861 Reference Digital Surround Controller allows you to modify any of 
the built-in presets, and save them for future use.

You can either save the changes to the built-in preset, or you can create up 
to 10 presets of your own, with names of your choice, so you can use them 
alongside the built-in presets. 

To save the preset settings

•   Make sure the menus are unlocked; see To unlock the menus, page 24. 

•   Press DSP (front panel) or Preset (remote) to select the preset you want 
to modify.

•   Change the preset parameters to the values you want to store; see To 
change a DSP parameter, page 26.

•   Press Store (remote or under the front panel).

The display shows the next available  user-defi ned preset.

For example:                                                  CD    User 1

•   If you want to overwrite an existing user-defi ned preset press A or V to 
select the preset you want to overwrite.

For example:                                                  CD    Classical

Alternatively you can choose the  built-in preset you started with.

For example:                                                  CD    Trifield

•   Press Store (remote or under the front panel).

The settings have been stored in the new or existing preset you selected. 

If you are defi ning a user preset you can now edit the name of the   preset if 
you wish.

A fl ashing cursor shows the
letter you are editing:                                   CD    •ser 1
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•   Press > or < to select the character position you want to edit.

•   Press A or V to change the character.

Each press steps through the sequence A to Z, a to z, 0 to 9, full stop, and 
blank. You can also select a blank directly by pressing Clear on the remote.

For example, you could change the 
name to:                                                         CD    La Scala

•   When you have entered the name you want to use press Store.

The display shows:                                         Stored 

To clear a     user-defi ned preset

•   Make sure the menus are unlocked; see To unlock the menus, page 24. 

•   Press DSP (front panel) or Preset (remote) to select the preset you want 
to clear.

•   Press and hold down Clear (remote) for several seconds.

The display shows:                                         Preset Clear

If you clear a preset that was saved over a built-in preset, the original 
preset name and settings are restored.
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  DSP presets

This chapter gives technical information about each of the DSP presets 

built in to the 861 Reference Digital Surround Controller including 

information about which preset you should select for different types 

of material. It also gives details of the special DSP parameters available 

for each preset.
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 Music DSP presets

The digital surround controller provides eight alternative music DSP presets 
designed for the reproduction of well recorded material, originally 
intended for replay over a traditional stereo pair of loudspeakers:

• Music
• Trifi eld
• Ambisonics
• Super
• MusicLogic
• PLII Music
• Stereo
• Direct

The Music DSP presets use the Music speaker layout.

   Music

The Music DSP preset extracts the mono and surround components of the 
original recording. These components provide an alternative representation 
of the original sound, and this representation is sometimes used for 
recording systems or in broadcasts such as FM radio. 

The mono element is equalised using a proprietary Meridian technique to 
match the tone colour of the centre speaker, and to compensate for the 
fact that the frequency response of human hearing changes with direction. 

The Music DSP preset is recommended for recordings made with spaced 
omnidirectional microphones, or using a mono-surround technique.

  Trifi eld

As for the Music DSP preset, the Trifi eld preset extracts the mono and 
surround components of the original recording. It then calculates the 
signals for the front, left, centre, and right speakers, using the phase and 
amplitude differences between the three front channels, to redistribute the 
sounds on a frequency-dependent basis. 

This gives a signifi cant improvement over traditional stereo, which converts 
the differences between the microphone signals into amplitude differences 
in the speaker signals. This version of the Trifi eld algorithm is virtually 
impossible to implement without digital signal processing.

Trifi eld is recommended for well-made recordings and stereo television 
broadcasts that are not Dolby Surround encoded. An advantage over the 
Music DSP preset is that the front stereo image is more focused, and the 
width of the image can be adjusted.
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  Music and Trifi eld DSP preset parameters

Parameter Options What it changes

 Centre Flat, EQ1–3 The timbre of the centre loudspeaker.

 Width† 0–1.5 The width of the image.

 Surr. Rear Surr. Rear, Surr. Side, Surr. 
All

Switches the surround signal between the 
side and rear speakers.

 R Filter Off, 1kHz, 3kHz, 7kHz The cutoff of high frequencies from the 
rear surrounds.

 S Filter Off, 1kHz, 3kHz, 7kHz The cutoff of high frequencies from the 
side surrounds.

† Trifi eld only.

  Ambisonics

The Ambisonics DSP preset can decode  UHJ format, the 2-channel stereo-
compatible encoding found on Ambisonically-recorded discs and 
broadcasts. This material is specifi cally encoded for surround reproduction 
and can give breathtakingly realistic sound when replayed using the digital 
surround controller.

Ambisonics surround sound is quite unlike conventional stereo. A special 
microphone technique picks up the sound of the original performance in 
all three dimensions, allowing an archive to be made which describes the 
soundfi eld exactly at that position. The microphone signals are then 
encoded using a phase-amplitude matrix to allow the effect to be conveyed 
on 2-channel carriers (like FM radio, LP, or CD).

The digital surround controller uses accurately matched, frequency-
dependent, phase-amplitude matrices to decode the signal and construct 
the signals for each speaker feed.

The fundamental difference between Ambisonics surround sound and 
conventional stereo is that the signals from all the speakers combine to 
produce a coherent soundfi eld at the listening position, giving the illusion 
that you are sitting inside the recording space whether you are at the exact 
central seat or well off to one side.

Of all the signal-processing options, Ambisonics is the one that requires the 
greatest attention to speaker choice and positioning.
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  Super

Super synthesises a signal from a conventional stereo recording or 
broadcast so that it can be decoded using the Ambisonic decoder. The 
result is especially effective for two particular types of recordings:

• Those using true coincident microphone techniques.
• Multi-tracked or multi-miked recordings.

   Ambisonics and Super DSP preset parameters

Parameter Options What it changes

 Width* 0 to 1 The width of the image.

 Position† A, C, E, G, I, K, M The seating position; the letters are like 
rows in a hall.

 Channels 7, 6, 5, 4 The number of speakers.

 R Filter Off, 3kHz, 7kHz, 9kHz The cutoff of high frequencies from the 
rear surrounds.

 S Filter Off, 3kHz, 7kHz, 9kHz The cutoff of high frequencies from the 
side surrounds.

* Super only.
† Ambisonics only.

  MusicLogic

MusicLogic is a music DSP preset based on ProLogic II with the addition of 
user-adjustable steering, designed to provide an exciting experience with 
many types of studio-produced music.

   MusicLogic DSP preset parameters

Parameter Options What it changes

 Roll Off, Low, Med, High The degree of left-right steering. 

 Yaw Off, Low, Med, High The degree of front-rear steering.

 Steered All Steered Rear, Steered Side, 
Steered All 

Which of the surround channels are 
generated by steering.

  PLII Music

The PLII Music preset is designed to use the Pro Logic II DSP processing 
mode to decode music sources. It provides additional Width, Dimension, 
and Panorama preset parameters to allow you to adjust the soundfi eld.
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      PLII Music DSP preset parameters

Parameter Options What it changes

 Steered All Steered Rear, Steered Side, 
Steered All 

Which of the four surround channels are 
generated by steering.

 Width 0 to 7 The centre spread, where 0 is full centre 
and 7 is full left and right. 

 Dimension -3 to +3 The spatial soundfi eld, where -3 puts the 
balance to the rear of the room and +3 
puts it to the front.

 Panorama No, Yes Extends the front stereo image to include 
the surround speakers, providing a wrap-
around effect new to Pro Logic.

  Stereo and   Direct

The Stereo preset passes the left and right input signals directly to the left 
and right main speakers. Any mono or front left and right subwoofers 
continue to be used.

With the Direct preset only the left and right main speakers are used, 
bypassing any spatial processing.

There are no additional DSP preset parameters for Stereo and Direct.
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  Logic DSP presets

The digital surround controller provides four DSP presets specifi cally 
designed for reproducing 2-channel or mono fi lm soundtracks:

• PLII Movie
• PLII THX
• TV Logic
• Mono

The Logic DSP presets use the Logic speaker layout.

   PLII Movie and  PLII THX

PLII Movie and PLII THX use the Dolby Pro Logic II DSP processing mode, 
and are the recommended choice for Dolby Surround encoded material. 
They also give excellent results with 2-channel sources not specifi cally 
encoded for Dolby Surround, including 2-channel Dolby Digital sources.

Pro Logic II re-creates 5.1-channel movie surround from the 2-channel 
source, using improved decoding techniques that preserve the directness of 
the soundfi eld, resulting in enhanced image stability compared with the 
original Pro Logic decoding. Meridian’s implementation of Pro Logic II was 
the fi rst in the world to receive Dolby approval, and uses proprietary code 
based on 48-bit precision to give outstanding clarity.

The PLII THX DSP preset provides additional signal processing refi nements 
developed by Lucasfi lm Ltd. These are designed to provide a better match 
between the sound of the movie theatre and a home cinema in the 
following ways:

• The front channels are re-equalised to correct for the higher treble often 
found in fi lm soundtracks.

• The surround channels are frequency-corrected using a timbre-matching 
process so that sounds moving front–back are more convincing.

THX can also be used with the 5.1 Movie DSP presets; see THX, page 45.

   PLII Movie and  PLII THX DSP preset parameters

Parameter Options What it changes

 Steered All Steered Rear, Steered Side, 
Steered All

Which of the four surround channels are 
generated by steering.

 Pro Logic Off, On On selects an emulation of the original Pro 
Logic decoding. 



PREFACE

43

DSP PRESETS

   TV Logic

TV Logic is a movie preset based on ProLogic II with the addition of user-
adjustable steering, designed to give higher intelligibility and a more 
appropriate spatial presentation for studio-based TV material.

   TV Logic DSP preset parameters

Parameter Options What it changes

 Roll Off, Low, Med, High The degree of left-right steering. 

 Yaw Off, Low, Med, High The degree of front-rear steering.

 Steered All Steered Rear, Steered Side, 
Steered All

Which of the surround channels are 
generated by steering.

  Mono

In the Mono DSP preset you can choose to listen to:

• Only one of two input channels, such as when different languages or 
material are carried on each channel.

• A combined version of the two input channels, such as if the material 
was originally mono and has been conveyed on a 2-channel carrier.

If Party? is set to No, the combined or selected signal is played only 
through the centre speaker, or the left and right speakers if there is no 
centre, to centrally localise high-frequency hiss and clicks.

Note: If Party? is set to Yes, full range bass is played through any speakers 
that are not supplemented by a subwoofer, and this may damage small 
speakers at high volume levels.

 Mono DSP preset parameters

Parameter Options What it changes

 Input Auto L+R, Input L, Input R, 
Input L+R

The channel selected.

 Academy Off or On Select On to include an equalisation 
(recommended by Lucasfi lm Ltd) to correct 
for a high-frequency balance in some old 
mono fi lms.

 Party? No or Yes Select Yes to play the mono signal through 
all speakers, including subwoofers.
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 5.1 Movie and 5.1 Music DSP 
presets

The digital surround controller provides nine DSP presets designed for 
processing multi-channel movie or music materials, whether from a multi-
channel source, or decoded from a 5.1 Dolby Digital, DTS, or MPEG signal.

 5.1 Movie DSP presets
• Cinema
• EZ
• EX
• THX
• THX EX
• THX Ultra2

The 5.1 Movie DSP presets use the 5.1 Movie speaker layout.

 5.1 Music DSP presets
• Discrete
• THX Music
• Ambisonics

The 5.1 Music DSP presets use the Music speaker layout.

     Cinema

The Cinema preset is recommended for listening to multi-channel movie 
soundtracks when no further processing is required. 

 Discrete

The Discrete preset is similar to Cinema, except that it uses the Music 
speaker layout.
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Discrete and Cinema DSP preset parameters

Parameter Options What it changes

 2+2+2* Off, 5.1, Side, 7.1, High Allows you to specify how DVD Audio channels 
3+4 should be interpreted: Off ignores them, 5.1 
and 7.1 use them for centre and LFE, Side uses 
them for the side speakers, and High uses them 
for ceiling speakers. 7.1 differs from 5.1 in that it 
duplicates the surround channels in the side 
speakers.

 Surr. Rear† Surr. Rear, Surr. Side, 
Surr. All

Allows you to specify which speakers the 
surround channels should be sent to in a system 
with four surrounds.

 R Filter Off, 1kHz, 3kHz, 7kHz The cutoff of high frequencies from the rear 
surrounds.

 S Filter Off, 1kHz, 3kHz, 7kHz The cutoff of high frequencies from the side 
surround.

 LFE -18dB to +10dB The relative level of the LFE bass channel.

  * Discrete only.
† Cinema only.

   THX

As with the PLII THX DSP preset, THX re-equalises the signals to suit 
domestic listening conditions, and applies frequency-response correction 
and decorrelation to the surround channels to make the surround sound 
more realistic. It can be used whether or not your other equipment is THX 
approved.

 THX DSP preset parameters

Parameter Options What it changes

 Surr. Rear Surr. Rear, Surr. Side, Surr. 
All

Switches the surround signal between the 
side and rear speakers.

  EX,   THX EX,   EZ,   THX Ultra2, and   THX Music

These presets are available if you have four surround speakers, and use 
ProLogic II decoding on a 5.1 source to create an additional two channels 
for the side speakers.

The EX and THX EX presets use a variant of ProLogic II to increase the 
directionality of the surround with movie soundtracks. They are 
recommended for movies marked as being recorded in Dolby Surround EX.

The EZ preset is a Meridian variation of EX that allows the steering to be 
varied from 7 (full EX steering) to 0 (no steering). Reducing the steering 
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increases the spaciousness of the surround and is useful for movies that are 
not Dolby Surround EX encoded, or that are DTS ES encoded.

THX Ultra2 and THX Music use a THX proprietary process called advanced 
speaker array to provide a mix of ambient and directional surround sounds 
using four surround speakers. Optimum performance of THX Ultra2 and 
THX Music is produced when the two rear speakers are placed close 
together behind the listening position. THX Ultra2 is recommended for 
movie soundtracks that are not Dolby Surround EX encoded, and THX 
Music is recommended for listening to multi-channel music.

EX, THX EX, EZ, THX Ultra2, and THX Music DSP preset 
parameters

Parameter Options What it changes

 LFE 0 to -30dB The relative level of the LFE bass channel.

 Steering* 0 to 7 The degree of steering; 7 is equivalent to 
EX, 0 is no steering.

* EZ only.

  Ambisonics

The Ambisonics preset allows you to decode multi-channel sources which 
have been encoded in Ambisonics B format. 

Ambisonics B format contains four independent channels of information to 
give a three-axis representation of the sound at the recording position. The 
signals are: mono sound pressure, left-right velocity component, front-back 
velocity component, and up-down velocity component. 

Using    dynamic range control

If the input format is Dolby Digital, the  5.1 Movie DSP presets provide an 
additional  Compress parameter to allow you to take advantage of the 
dynamic range information provided in the Dolby Digital format to provide 
dynamic range control without the distortion involved in analogue 
methods. 
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The Compress parameter allows you to set one of the following options:

Option Description

Compress off No compression.

Quiet boost Provides a moderate amount of bottom-up compression. This raises 
quiet sounds above the background noise, which is ideal for 
demonstration and quiet listening.

Compress med Provides moderate amounts of both bottom-up and top-down 
compression.

Loud cut Provides a moderate amount of top-down compression. This reduces 
loud sounds.

Compress max Provides full bottom-up and top-down compression. Quiet sounds are 
raised to be audible and loud passages are minimised to avoid 
disturbance, which is useful for late-night listening.

Compress mix Bypasses dialogue normalisation and references the sound pressure 
level in the studio where the material was mixed

Dialog normalisation display

Dolby Digital audio streams include  Dialog Normalisation and  Mix levels, to 
specify the recommended listening level of the soundtrack.

The surround controller uses the Dialog Normalisation level to adjust the 
volume level so that the soundtrack is reproduced at the correct absolute 
level, assuming the system is calibrated to produce 75dB SPL at volume 87.

The Mix level is an alternative level which you can select by setting the 
Compression parameter to Mix.

The Dialog Normalisation or Mix level is shown in a separate display option 
for Dolby Digital sources:

For example: DialNorm     -31

Or: MixLevel     -27
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  Configuring the digital surround controller 

without a computer

The 861 Digital Surround Controller can be set up for most standard 

confi gurations of loudspeakers and sources using just the front-panel 

controls and Meridian System Remote. 

This chapter explains how to confi gure the digital surround controller 

without using a computer, and then how to calibrate the loudspeakers 

and sources for your particular system.

Alternatively, for complete control over all aspects of the digital 

surround controller’s confi guration you can set up the unit from a 

computer using the Meridian Confi guration program. For full 

information refer to the next chapter.
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   Choosing a standard setting

The digital surround controller provides six standard settings, called  Types, 
which confi gure all aspects of the 861 into the most commonly needed 
confi gurations. In addition, any User Types you create using the Meridian 
Confi guration program are also available.

Types 0 to 5 are factory settings, designed to cater for the most commonly 
needed confi gurations of associated equipment.

These standard Types are shown in the following table:

Type Speakers Music Sub Logic Sub 5.1 Movie Sub

0 All analogue. LFE Centre LFE

1 All analogue. Mono Mono Mono

2 All digital. LFE Centre LFE

3 All digital, large centre. None None None

4 Digital left, right, and centre. LFE Centre LFE

5 Digital left and right. LFE Centre LFE

In this table Music Sub refers to a subwoofer used for all Music DSP presets, 
Logic Sub to a subwoofer used for all Logic DSP presets, and 5.1 Movie Sub 
to a subwoofer used for all 5.1 Movie DSP presets.

Choosing one of the Types overrides any other confi guration you may have 
performed, and so can be used to reset the confi guration of the unit. 
Note: Selecting a Type will clear any confi guration and calibration changes 
you have made, or any DSP presets you have defi ned.

If your digital surround controller is fi tted with a video card, and you have 
a video source connected, the on-screen display also provides additional 
text explaining about each Type. 

To select a  standard setting

Warning: This procedure will reset any confi guration and 
calibration changes you have made.

•   Select a video source to produce an on-screen display.

•   Put the digital surround controller into Standby by pressing Off (front 
panel or remote).
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•   Hold down the A key on the front
panel until the display shows: Type in... 3

•   Keep holding down the A key for a further three seconds.

The display will show:                                   Type- please wait.

If you have an on-screen display it shows:

 

Then after a short delay the display shows the current Type.

For example:                                                  Type   3

If you have an on-screen display it shows information about the Type; for 
example:

 

•   Press A or V on the front panel to change the Type number.

The display shows:                                         Typing, please wait.
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If you have an on-screen display it shows:

 

•   Wait for one second, and then put the digital surround controller into 
standby by pressing Off (front panel or remote).

•   Switch on again to use the standard settings you have selected.

Setting up the digital surround controller with other 
Meridian equipment

If you are using the 861 with other Meridian equipment, such as the 800 
Reference DVD/CD Player, you should set up the Comms with the following 
automatic setup procedure:

•   Switch all the units to standby.

•   Press Clear (remote).

Each unit will display:                                    Auto Setup

The 861 will then be designated as
the controller, and display:                           Controller

This is the unit that will respond to the remote.

All the other units will be confi gured
as non-controllers, and display:                    Not Controller

Your system is now set up and ready for use.

•   If for any reason the automatic setup does not give the confi guration 
you want, restore the default operation by selecting one of the standard 
Types; see Choosing a standard setting, page 50.
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Calibrating the system

To help you to set up your installation to give the best possible sound with 
any particular combination of associated equipment, the 861 Reference 
Digital Surround Controller includes a built-in calibration procedure.

This calibration procedure uses test signals to present a series of sounds, 
which you use to adjust certain aspects of the system to their optimum 
settings.

You should work through the calibration procedure the fi rst time you set 
up your surround sound system, and whenever you want to check the 
calibration, such as after changing the layout of your room.

Using the  calibration procedure

We recommend that you perform the calibration procedure using the 
Meridian System Remote and from the listening position.

As you run the calibration procedure the name of each calibration test is 
shown on the front-panel display, followed by the parameters adjusted in 
the test.

If your digital surround controller is fi tted with a video card, and you have 
a video source connected, the on-screen display also provides additional 
text explaining what to do. 

Each calibration test uses a test signal designed to give the best results. 

 Using a  Sound Pressure Level meter

Although you can perform the calibration procedure by ear, it is 
recommended that you perform the tests using a Sound Pressure Level 
meter, available fairly cheaply from Tandy/Radio Shack, or your Meridian 
dealer may be able to lend you one.

Set the Sound Pressure Level meter to C weighted, and Slow. Take readings 
with the meter at the listening position, pointing vertically. You should 
hold the meter with an outstretched arm to minimise refl ections from your 
body.

To start the  calibration procedure

•   Put the digital surround controller into standby by pressing Off (front 
panel or remote).

•   Press and hold the Calibrate key, under the front panel, for at least fi ve 
seconds.
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The display shows:                                         Calibration

If you have an on-screen display it shows:

 

After a few seconds the 
display shows:                                                Left   Level  +0.0dB

For more detailed information about this and the other calibration tests 
see the following sections.

To move between the calibration tests

•   Press > (remote), or the corresponding menu key under the front panel.

•   Press < (remote), or the corresponding menu key under the front panel, 
to move back to an earlier test.

To jump to the next set of tests

•   Press Store.

The calibration tests are described in the following sections.

To exit from the  calibration procedure

You can exit from the calibration procedure at any time, and any 
parameters you have set will be retained.

•   Press Off (front panel or remote).
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Calibration tests

Levels 

These tests allow you to adjust the output level to each speaker 
individually, and it follows the general guidelines from Dolby Laboratories 
and Lucasfi lm Ltd. A Sound Pressure Level (SPL) meter can be useful at this 
stage; see Using a Sound Pressure Level meter, page 53.

In each test the display shows the speaker being tested, and the current 
relative level.

For example:                                                  Left   Level  +0.0dB

If you have an on-screen display it shows:

 

•   Press > or < to move between each of the speakers in the layout in the 
sequence: Left, Centre, Right, Side R, Rear R, Rear L, Side L, and 
subwoofers.

•   Press A or V to adjust the level of the speaker. Ignore any tonal 
difference. 

For correct  THX reproduction you should adjust each speaker to 75dB SPL 
using an SPL meter. Even if your speakers are not THX approved this setting 

is recommended.

Note: You cannot directly set the level of a subwoofer 
by ear, because low-frequency noises sound quieter. To 

set the subwoofer correctly either use an SPL meter, or set 
it by ear and then reduce the subwoofer gain by 15dB to 

correct for human hearing.

•   When you have completed the Levels section press > or Store to 
proceed to the next test.

If you have Meridian DSP 

loudspeakers they cannot be set 

above +0dB.
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Distance

These tests allow you to adjust the delay of each of the speakers in the 
layout to  time-align the system so that sounds are coincident when they 
arrive at the listening position.

Before setting up the speaker outputs you need to measure the distance, in 
feet and inches, to each speaker from the listening position:

CentreSubLeft Right

Left
Side

Right
Side

Left Rear Right RearSurround Sub
 

Measure from the ear height at the listening position to the tweeter on 
each speaker (where applicable).

•   Press > or < to move between each of the speakers in the layout.

The display shows the speaker being tested, and the distance in feet.

For example:                                                  Left   Distance 18'0

If you have an on-screen display it shows:

 

•   Press A or V to change the distance, in feet. 
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Repeat this for each of the speakers in your layout.

•   Press > or Store to proceed to the next calibration stage.

Fine tuning

These tests allow you to fi ne-tune the phase and delay of each speaker 
when used in conjunction with other speakers on the layout.

•   Press > or < to move between each of the speakers in the layout.

The fi rst display allows you to adjust the phase.

For example:                                                  Left   Phase       +

If you have an on-screen display it shows:

 

The next display shows the distance (or delay) for the same speaker.

For example:                                                  Left   Distance 18'0

If you have an on-screen display it shows:
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Choose the correct setting as follows:

Setting What it sounds like

Correct The sound between the speakers is very even, and does not change 
radically as you move your head.

Incorrect The sound appears diffused, and changes in timbre and apparent location 
as you move your head.

Pay particular attention to the centre channel, as this can have a dramatic 
effect on the overall sound.

As you increase the delay the speaker will appear to move away from you.

•   Press > or Store to proceed to the next calibration stage.

Speaker size

These tests allow you to determine the bass handling capability of large 
analogue speakers and subwoofers. Once set, the 861 will limit the bass 
level to protect the speakers from potential damage. 

In each test the display shows the speaker being tested and the level of the 
test signal, followed by the limit value set for the speaker.

For example:                                                  Left   Size     5/19

If you have an on-screen display it shows:

•   Press > or < to move between each of the speakers under test.

•   Press A and V to adjust the limit value for the speaker. 

As you increase the limit value, the test signal will gradually get louder up 
to the limit value. Reducing the limit value will cause the test signal level to 
drop immediately.

•   Adjust the limit value until the speaker is just beginning to produce 
distortion, indicating that it is reaching its bass handling limit.
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You have now completed the calibration of your system.

 •  Press Off (front panel or remote) to exit from the calibration procedure.
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Setting up sources 

This section explains how to use Gain/Sub mode to set up the sources 
connected to the digital surround controller, and confi gure them to suit 
your other equipment.

You can also adjust the subwoofer crossover frequency to suit the 
subwoofers in your system.

To turn on  Gain/Sub mode  

•   Put the digital surround controller into standby by pressing Off (front 
panel or remote).

•   Press and hold the Confi gure key under the front panel for at least fi ve
seconds.

The display shows:                                         Gain/Sub On

The digital surround controller will then return to standby with Gain/Sub 
mode turned on.

Gain/Sub mode adds two extra options to the DSP parameter menus: 
Sensitivity and Xover.

To turn off Gain/Sub mode

•   Repeat the above procedure until 
the display shows: Gain/Sub Off

To adjust the sensitivity of a source

To obtain the best signal-to-noise ratio for your analogue sources you can 
adjust the sensitivity of each input to give the highest level that does not 
produce clipping.

•   Turn on Gain/Sub mode, as described above.

•   Select the source you want to adjust, with loud source material playing.

•   Press < or > (remote or under the front panel) until the display shows 
the current sensitivity.

For example:                                                  Radio 2.0V In

•   Press A or V (remote or under the front panel) to change the sensitivity.
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You can select between sensitivities of 0.5V (most sensitive), 1.0V, 2.0V, or 
2.5V (least sensitive).

If the sensitivity is set too high the input will  clip the loudest passages.

The display shows, for example:                   Radio 0.5V In Clip

In this case reduce the sensitivity.

If you have selected a digital source you cannot adjust the sensitivity.

The display shows, for example:                   CD    Not Analogue

To adjust the  subwoofer  crossover frequency

The digital surround controller allows you to adjust the crossover frequency 
of any subwoofers between 30 and 150Hz. The crossover can be set 
independently for Music, Logic, and 5.1 Movie speaker layouts. The default 
is the THX standard of 80Hz. For details of which speaker layout is used by 
each DSP preset see Layouts, page 6.

•   Turn on Gain/Sub mode, as described above.

•   Press < or > (remote or under the front panel) until the display shows 
the current crossover frequency.

For example:                                                  Radio Xover   80Hz

•   Press A or V (remote or under the front panel) to set the crossover 
frequency.

For THX loudspeaker systems you should leave the crossover setting at 
80Hz.

80Hz is also the recommended setting for all movie listening. You may 
prefer, however, to lower the crossover frequency for music if your main 
speakers have good bass handling down to, say, 50Hz.
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Sinewave sweep test

The 861 Reference Digital Surround Controller includes a sinewave signal 
test, to help you set the subwoofer crossover frequencies, or check for 
room resonances.

•   Select a PCM source; eg an analogue source or CD.

•   Press Confi gure (under the front panel).

The displays shows:                                       CD    Sine    80.0Hz

An 80Hz sinewave will be played through all channels.

You can change the test signal using the menu keys, as described in the 
following sections.

To change the sweep rate

•   Press < or > (remote or under the 
front panel) until the display shows: CD    Pause   80.0Hz

•   Press A or V to change the sweep rate and direction, as follows:

Display Description

CD        >>  88.5Hz
Fast sweep up.

CD         >  81.5Hz
Slow sweep up.

CD    Pause   80.0Hz
Paused.

CD         <  78.5Hz
Slow sweep down.

CD        <<  70.5Hz
Fast sweep down.

The sine sweep will stop when it reaches 0.5Hz or 200Hz.

To change the volume

•   Use the volume keys in the usual way.

Warning: Very loud low-frequency signals may damage speakers.
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To select other test signals

•   Press < or > (remote or under the front panel) until the display shows 
the current signal.

For example:                                                  CD    Sine         

•   Press A or V to choose between the following test signals:

Display Description

CD    Sine
A sinewave.

CD    Silent
Silence.

CD    Input
The source signal in mono (left + right).

CD    Noise
Pink noise (band pass 500Hz to 2kHz for 
main channels).

To select the channel

•   Press < or > (remote or under the front panel) until the display shows 
the current channels.

For example:                                                  CD    All Channels

•   Press A or V to select a specifi c channel, or All Channels.
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Configuring the digital surround controller 

using a computer

The 861 Reference Digital Surround Controller provides a fl exible 

range of customisation options which you can change to suit your own 

preferences and the other equipment in your system.

This chapter explains how to install the Meridian Confi guration 

program, and use it to create your own confi gurations of the 

digital surround controller. 
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The  Meridian Configuration 
program

The Meridian Confi guration program is a stand-alone Windows-based 
application that lets you design your own confi guration of each 800 Series 
product to suit your own personal preferences, and the particular 
confi guration of other equipment in your system.

The Meridian Confi guration program provides the following sections to 
allow you to control the corresponding aspects of each 800 Series product’s 
operation: 

Setup 
           Specifi es general features of the product’s operation, including 

the position of the on-screen display, the information provided 
on the front-panel displays, the start-up volume, and settings 
affecting its operation in multi-room systems.

Speakers 
       Confi gures the product’s outputs to suit the type of each 

amplifi er and loudspeaker in your system, and if appropriate 
the layout of the loudspeakers, to ensure that you get perfect 
surround sound performance.

Presets
          Customises the settings of the built-in DSP presets, and creates 

additional presets of your own based on the built-in presets.

Sources
         Customises the operation of each of the sources, including the 

presets used by each source for each of the audio formats, the 
digital, analogue, and/or video inputs used for that source, and 
additional information about the type of each source.

Cards
           Displays information about each of the cards in the product, 

and lets you change the confi guration of a card, and add or 
remove cards.
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Installing t he Meridian 
Configuration program

Requirements

To use the Meridian Confi guration program you need:

• A computer running Windows 95, 98, 2000, ME, NT 4, or XP.
• A 100MHz or faster Pentium-class processor.
• At least 16Mbytes of RAM.
• 5Mbytes of free disk space.
• A vacant 9-pin serial port assigned to one of COM1 to 4.

The software requires a mouse or similar pointing device – it cannot be 
operated solely from the keyboard.

 To install the Meridian Confi guration program

•   Insert the Meridian Confi guration program installation disk.

•   Choose Run... from the Start menu.

•   Type A: setup and press R.

•   Follow the on-screen instructions.

If you have an 800 Reference DVD/CD Player

If your equipment includes both an 861 Reference Digital Surround 
Controller and an 800 Reference DVD/CD Player confi gure the DVD/CD 
Player fi rst as described in the corresponding chapter of the 800 Reference 
DVD/CD Player User Guide.
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To run t he Meridian Confi guration program

•   Click Start, point at Programs, then click Meridian Confi guration.

The Meridian window will be displayed:

 

T h e toolbar provides a convenient way of accessing the most important 
menu options:

Button Option Function

 
New Creates a new settings fi le.

 
Open Opens an existing settings fi le.

 
Save Saves the current settings fi le to disk.

 
Fetch Fetches the current confi guration of the attached 

product(s).

 
Store Stores the current settings and User Types to attached 

products.

 
Disconnect Disconnects the program from attached products.

 
Add product Allows you to add a product to the settings fi le.

 
Copy Copies text or settings onto the clipboard.

 
Paste Pastes text or settings from the clipboard.

 
Print Allows you to print a copy of your settings.

 
About Displays program information.
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To connect  the serial cable

The serial cable is symmetrical, and can be connected either way round.

•   Connect one end to the RS232 connector on the COMPUTER card on the 
back panel of the 861 Reference Digital Surround Controller.

•   Connect the other end to one of the serial ports on the PC or PC 
notebook computer.

Then specif y the serial port you are using as follows:

•   C hoose Options from the View menu to displa y the Options dialogue 
box:

 

•   Select the port you want to use and click the OK button.
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Creating a new  settings file

This section explains how to create a new settings fi le, using the Meridian 
Confi guration program, and how to enter personal information to identify 
the settings in your product.

The fi rst step is to fetch the initial settings from the digital surround 
controller, to use as a starting point for your confi guration.

•   Click the Fetch button in the toolbar:  

The Progress dialogue box will show you the progress as the settings are 
fetched:

 

A new settings fi le will be created for you, with the initial name MSF1, and 
the Meridian window will show a Surround controller icon to identify 
the product you are confi guring.

 

•    Choose Save As from the File menu, enter an appropriate name for the 
fi le and click the Save button.
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To display the settings

•   Double-click the Surround controller icon, to open it and display the 
settings it contains. 

The left-hand panel of the Meridian window will change to show the 
following three ic ons:

 

Owner lets you enter personal information, for future reference, and 
choose the message displayed when you fi rst switch the unit  on, and 
Settings is the initial confi guration in the settings fi le.

Double-c licking Return to top level takes you back to the previous level.

To ent er your personal details

•   Cl ick the Owner icon in the left-hand panel.

•   Enter any text you like in the Dealer, Owner, and Description fi elds.
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You can enter up to 20 characters in each fi eld, the size of the 861 front-
panel display:

 

The Owner text will be displayed when you turn the product on. The 
Dealer and Description text are displayed after the product version and 
serial numbers if you hold down the front-panel Display key in standby.

The options on the Advanced tab are for use by a dealer in setting up a 
multi-room system, and to upload a new version of the software to the 
product, and it is recommended that you do not change these settings.

To display or edit the settings

•   Double-c lick the Settings icon. 

The Meridian window will change to show the fi ve categories of settings 
contained in the settings fi le: Setup, Speakers, Presets, Sources, and 
Cards.

The options available in each case are explained in the following sections.

At this stage you may fi nd it useful to maximise the Meridian window so 
you can see all the options on each screen.
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 Setting up speakers

This section describes how to use the Meridian Confi guration program to 
confi gure the 861 Reference Digital Surround Controller for the 
confi guration of loudspeakers in your system, and specify information 
about the type of each speaker, for optimum performance.

The fi rst stage in setting up the speakers is to specify the number of 
speakers in the layout, and the type and size of each speaker. 

The 861 Reference Digital Surround Controller can support up to 10 
loudspeakers.

To   specify the speaker layout

•   Click Speakers in the left-hand panel of the Meridian window.

•   If necessary click the  Layout tab to display the Layout page of speaker 
settings.

•   Specify the type of each speaker by selecting the appropriate option 
from each of the drop-down menus.

As you change the options the layout illustration will change to show the 
resulting layout.

If you select a combination of options that is not supported, the other 
options will be adjusted accordingly to ensure that the whole confi guration 
is valid.

For example, if you specify Two rears and two sides, and then select two 
subwoofers, the side speakers will be removed to allow you to have the 
subwoofers.

The options available for the Mains, Centre, Surrounds, and 
Subwoofers drop-down menus are explained in the following sections.

Mains
Use the Mains drop-down menu to specify the size and type of the main 
speakers.

•   Choose Large if your main left and right speakers are large, with good 
bass performance, and you want to use them for full range 
reproduction. 

•   Choose Small if your main left and right speakers do not have a good 
bass response, or your room is large and you want to use one or more 
subwoofers to handle the bass for the system.



CONFIGURING 
USING A COMPUTER

74

•   Choose analogue, DSP, or 96.24 DSP according to the type of each 
speaker.

The following table gives recommended settings for Meridian 
loudspeakers:

Loudspeaker Recommended setting

DSP8000, DSP7000, DSP5500HC Large 96.24 DSP

DSP5000, DSP5500, DSP6000, 
or DSP6000C

Large DSP or Large 96.24 DSP*

DSP5000C Small DSP or Small 96.24 DSP*

M60 Large analogue

M60C, M33, or A500 Small analogue

DSP33, DSP420 Small 96.24 DSP

*96.24 versions.

Centre
Use the Centre drop-down menus to specify which presets use the centre 
speaker, and its size and type.

•   From the fi rst drop-down menu choose one of the following options:

Option Description

None If you do not have a centre speaker.

Movies only If you want to use the centre speaker for Logic and
5.1 Movie speaker layouts only.

Movies and music If you want to use the centre speaker for all layouts.

•   From the second drop-down menu specify the type of the centre 
speaker; the options are as for the main speakers.

Surrounds
Use the Surrounds drop-down menus to specify the number and type of 
the surround speakers.

•   From the fi rst drop-down menu specify the number of rear, side, and 
front ceiling speakers you have in your surround system. 

•   Use the Sides, Rears, and Ceilings drop-down menus to specify the 
types of the corresponding speakers.
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Subwoofers
Use the Subwoofers drop-down menus to specify the number of 
subwoofers, and the DSP presets that use them.

If your main left and right speakers are small you will need to use one or 
more subwoofers to handle the bass. You can choose between appropriate 
combinations of mono (front), centre, left and right, or surround.

If your main left and right speakers are large you can use one or more 
subwoofers to augment the bass from the centre channel. With 5.1 sources 
an additional option is to use the subwoofer only for the LFE channel.

You can specify a different subwoofer confi guration for Music, Logic, and 
5.1 Movie speaker layouts.

The Advanced checkbox is for dealer use only, and it is recommended that 
you leave this unchecked unless you have spec ial requirements .

To specify the speaker sizes

•   Once you have specifi ed the speaker layout for your system, click the 
Sizes tab to display the Sizes page of speaker settings: 

 

This allows you to set up speaker protection for the 5.1 sources, the type of 
each subwoofer, and peak-level limiting.
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Speaker protection
Because of the high bass levels that 5.1 materials are capable of 
reproducing, the digital surround controller allows you to set up automatic 
protection of each full-range speaker or subwoofer.

A setting of Max corresponds to no protection, and 0 corresponds to full 
protection. By default any Meridian DSP loudspeakers in your system are 
set to Max, as these include built-in protection.

You can use SizeCalc to help you calculate the correct value for your 
speakers:

•   Click the Size calculator butt on to display the SizeCalc window:

 

•   Specify the number of bass units in each speaker (woofers), the size of 
each unit, and the design of the speaker.

The size value is displayed in the SizeCalc display.

•   Type the size into the appropriate fi eld.

Subwoofer fi ltering and type
For each subwoofer in the system you can specify the subwoofer fi ltering, 
and its type.

•   Specify the fi ltering from the following options:

Option Description

Narrow The digital surround controller provides a low-pass cut off; the 
subwoofer’s crossover should be bypassed. This is the recommended 
option.

Wide The subwoofer includes a crossover.

•   Specify the type of subwoofer as  Analogue or DSP.
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To complete the speaker setup

You have now completed the fi rst stage of setting up the digital surround 
controller, and you should save the changes you have made by choosing 
Save from the File menu.

You can ignore the Distances, Crossovers, Precision, Phase/Gain, and 
Connection pages of settings for the moment; these will allow you to 
check the values you have set up when you calibrate the digital surround 
contr oller.
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 Setting up sources

This section describes how to use the Meridian Confi guration program to 
confi gure the sources provided by the digital surround controller.

To set up so urces

•   Click the Sources icon in the left-hand panel of the Meridian window.

The right-hand panel shows a list of the 12 sources that are available. For 
each source you can display four pages of settings by clicking on the 
Options, Audio, Video, or Advanced tabs. 

To confi gure the source options

•   Select the source in the list of sources.

•   Click the Options tab:

 

•   Select Source exists if you want to use this source.

Disabling this options prevents the source from appearing when you press 
the Source key, or the corresponding source key on the Meridian System 
Remote.
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•   If you want, you can change the name displayed when the source is 
selected by editing the Name fi eld.

The name can consist of up to fi ve letters, digits, or the characters space, 
full-stop, and minus. The name you specify is shown in the list of sources, 
followed by the Meridian System Remote key used to select the source in 
brackets.

•   In the Presets section specify the DSP preset you want to use for each of 
the alternative content types:  Music 2 (2-channel music),  Music 6 (multi-
channel music),  Movie 2 (2-channel movie soundtrack), or  Movie 6 
(multi-channel movie soundtrack).

Each drop-down menu gives the built-in and user-defi ned DSP presets 
appropriate for that  content type:

Content type Presets available

Music 2, Movie 2 Direct, Music, Trifi eld, Ambisonics, Super, Stereo, MusicLogic, Mono, 
TV Logic, PLII Music, PLII Movie, PLII THX.

Music 6, Movie 6 Discrete, Cinema, EZ, EX, THX, THX EX, THX Ultra2, THX Music.

To  s pecify the audio connections

•   Click the Audio tab to show the connections for the audio inputs.
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•   Select the card in the Card list to specify the location of the connector 
used for the source.

•   From the Input on card drop-down menu specify the digital or 
analogue audio input you want to use for the source, or Last valid to 
leave the input unchanged when you select the source.

You can create a source with Input on card set to Last valid if you want it 
to change some other aspect of the current source, such as its DSP preset, 
without changing the selected input.

If you have specifi ed a digital input for the main audio input:

•   Specify the precision for the source by choosing an option from the 
Precision drop-down menu. 

All CDs and LaserDiscs are currently 16 bits. The 800 DVD/CD Player provides 
24 bits. If in doubt choose 24-bit.

If you have chosen an analogue input for the main audio input:

•   Specify the sensitivity of the input by choosing an appropriate option 
from the Sensitivity drop-down menu.

Note: You can also adjust the sensitivity of any analogue source 
interactively, using Gain/Sub mode. See To adjust the sensitivity of a source, 
page 60.
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To specify the  video connections

•   Click the Video tab to show the connections for the video inputs:

 

•   Select the card in the Card list to specify the location of the connector 
used for the source.

•   From the Input on card drop-down menu specify the video input you 
want to use for the source, or Last valid to leave the video input 
unchanged when you select the source.

You would usually set Input on card to Last valid for audio sources such 
as CD, Radio, Tape1, and  Tape2.
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To set the advanced  source options

•   Click the Advanced tab to show the Advanced page of settings:

 

•   If the source is a Meridian product set Comms type to 1C for a CD 
player, 2C for an FM tuner, and 3C for a DVD player. Otherwise set it to 
none.

•   If you have two Meridian source units of the same type you can 
confi gure them to have different Comms addresses. You can then select 
the appropriate source by specifying its Comms address in the Comms 
address fi eld.
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The following additional options are available. You should only change 
these with advice from your dealer:

Option Description

Delay for audio sources to avoid DTS 
noise (DTS delay)

Avoids the noise caused by switching to a DTS 
source. Should not be selected for video sources as 
it will cause the sound to be out of sync with the 
picture.

Only ever play DTS for this source Creates a video DTS source that will avoid any DTS 
noise when switching audio formats.

Number of video frames of delay to 
apply to audio

Adds a delay required by certain video systems.

Poor digital audio source – frequency 
out of range

Select this if you have diffi culty locking to the 
source.

•   Select any of Triggers 1, 2, or 3 to activate the specifi ed trigger outputs 
when this so u rce is selected.

•   Select any of the DTS 10dB LFE boost options to add an LFE boost for 
the corresponding audio format(s).
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Configuring  presets

The 861 Reference Digital Surround Controller provides 24 built-in presets 
and the Meridian Confi guration program lets you confi gure the DSP 
parameters of any of the built-in presets to suit your own preferences.

You can also create up to 10 additional user-defi ned presets. Each user-
defi ned preset is based on one of the built-in presets, and can have any 
name of your choice.

To set up presets

•   Click the Presets icon in the left-hand panel of the Meridian window.

The right-hand panel shows a list of the 20 built-in presets, and the 10 
unused user-de fi ned presets.

To modify a built-in  preset

•   Select the preset in the list of presets. 

The default DSP parameters will be displayed:

 

•   Adjust the parameters as required.
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Note: The treble and bass settings will not be available if your system 
includes DSP loudspeakers, because in this case the DSP speakers handle the 
treble and bass adjustments.

For more information about the DSP parameters available for each DSP 
preset see DSP presets, page 37.

If you have modifi ed the DSP parameters from their defaults, (modifi ed) is 
displayed after the preset name in the list of presets.

 To choose the room correction profi le for a preset

If you have created room correction profi les with the Meridian Room 
Correction program, you can select a profi le for each preset. For more 
information see Using Meridian Room Correction, page 99.

•   Choose the profi le from the EQ profi le drop-down menu at the bottom 
right of the dialogue box:

Only profi les appropriate to the preset’s speaker layout will be available, or 
(Bypass) to use no profi le.

If you have run the Meridian Room Correction program Set up wizard the 
profi les Mus, Log, and Mov will be created for the Music, Logic, and 5.1 
Movie Speaker layouts.
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To restore the DSP parameters to their defaults

•   Select the preset in the list of presets.

•   Click the Reset to default bu tton.

To create a user-defi ned  preset

•   Select the preset you want to use as the basis for the user-defi ned 
preset.

•   Click the Copy as new preset button. 

The new preset is created in the fi rst available space after the built-in 
presets.

•   Select the new preset you have created.

•   Edit the preset name to identify the preset.

Initially the name is set to be the same as the built-in DSP preset it was 
based on, but you can chose any name of up to 8 letters, digits, or the 
characters space, full-stop, or minus; eg Football.
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To delete a user-defi ned  preset

•   Select the preset in the list of presets.

•   Click the Delete this preset button.

To copy a preset to a specifi c position in the list of 
user-defi ned presets

•   Highlight the preset you want to copy.

•   Choose Copy from the Edit menu, or click the 
Copy button in the toolbar:  

•   Highlight the user-defi ned preset or empty position you want to replace.

•   Choose Paste from the Edit menu, or click 
the Paste button in the toolbar:  
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 Configuring cards

The Cards panel displays information about each of the cards in the 
product, and lets you change the confi guration of a card, and add or 
remove cards.

Changes to this panel should only be made by an experienced Meridian 
dealer, and this will normally only be necessary if you upgrade the 861 
Reference Digital Surround Controller by adding a new card.

 To set up cards

•   Click the Cards icon in the left-hand panel of the Meridian window.

The right-hand panel shows a list of the cards fi tted to the product, and 
allows you to add cards or remove cards:

 

Note: After adding or removing cards, New or Missing will be shown in 
the Status column. The digital surround controller will still function 
correctly, and the status will be updated when you next reset its 
confi guration to one of the standard or user-defi ned types; see Choosing a 
standard setting, page 50.



CONFIGURING 
USING A COMPUTER

89

To change the address of a card

If your unit has more than one card of the same type you will need to 
select the card address.

•   Double-click the card in the Card column

The Card Properties dialogue box shows the card’s current setting:

 

•   Select the address you want to use and click the OK button.
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Changing the  setup options

The fi nal stage in editing the settings is to confi gure the general Setup 
options.

To change the setup options

•   Click the  Setup icon in the left-hand panel of the Meridian window.

•   If necessary click the Setup tab to display the Setup page of options:

The Setup options will be displayed:

 

The options are described in the following table:

Option What it means

Lock settings on product Locks the parameters.

Contrast and Brightness Set the default brightness and contrast for the front-
panel display.

On-screen display position Specifi es the default position of the on-screen display.

Tape card Specifi es the level for each of the two tape outputs and 
the headphone output available on the optional Tape 
Card.
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  To change the   advanced setup options

Additional setup options are provided on the Advanced page.

•   Click the Advanced tab to display the advanced options:

 

The options are described in the following table:

Option What it means

Multi-room displays Includes displays of information from Meridian sources; 
eg CD track number or FM tuner frequency.

 Diagnostic displays Includes diagnostic displays in the display options.

Meridian DVD present If selected, the menu keys on the Meridian System 
Remote operate the 800 Reference DVD/CD Player 
menus and the Function menu keys operate the digital 
surround controller menus.

Disable VS10 On Screen Display Select this if you are using a VS10 Video Card with a 
VS00 card for S-video to composite conversion.

Volume on startup Specifi es the start-up volume; only available for 
analogue speakers.

Comms controller status Specifi es whether the digital surround controller is 
controller, not controller, or set automatically.

System and Copy address For multi-room setups.

 Meridian High Resolution If the 861 is Meridian High Resolution compatible, and 
the left, right, and centre speakers are 96.24 DSP types, 
specifi es whether the digital output uses Meridian High 
Resolution for all sources, or only when necessary.
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Calibrating the settings of your 
system

Once you have edited the settings to suit the confi guration of your system, 
the next step is to store the settings to the digital surround controller and 
use the calibration listening tests built into the 861 to calibrate it for 
optimum performance.

Alternatively to omit this step proceed to Creating a User Type, page 94.

To save the  settings

First save the settings to your PC hard disk.

•   Choose Save from the File menu, or click the 
Save button in the toolbar: 

To print a summary of  settings

At this stage it is useful to print a summary of the speaker and source 
settings, so that you can check that they correspond to your system 
confi guration.

•   Check that there is a printer connected to your PC.

•   Click the Settings icon in the left-hand panel of the Meridian window.

•   Click the Print sources and outputs summary button.

To  store the settings to the digital surround controller

•   Switch on the 861 Reference Digital Surround Controller, and check that 
the serial cable is connected between the digital surround controller and 
the PC.

•   Click the Store button in the toolbar: 

The digital surround controller 
will display:                                                    Receiving Data...

The following Progress dialogue box shows how the operation is 
progressing:
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If there is a problem click the Details button to see more information 
about the problem. 

When the download is complete the digital surround controller will 
automatically reset itself to use the new settings, and show the owner 
name you defi ned:

For example:                                                  Zachary Ford

To calibrate the loudspeakers

Now proceed through the calibration procedure to set the correct relative 
level, delay, and phase for each of the loudspeakers in the system. See 
Calibration tests, page 55.

To adjust the sources

The second calibration stage involves adjusting the sensitivity of the 
analogue sources; see Setting up sources, page 78.

To fetch the calibrated settings

Finally fetch the calibrated settings back from the digital surround 
controller as follows:

•   Make sure your settings fi le is loaded into the Meridian Confi guration 
program.

•   Click the Fetch button in the toolbar: 

The Progress dialogue box will show you the progress as the settings are 
fetched:

 

You can verify that the source adjustments you made are now included in 
the settings by checking the Audio page of the Sources settings option.
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 Creating a  User Type

Once you have fetched the calibrated settings from the digital surround 
controller, the fi nal step is to store them permanently to the product as a 
User Type, so that you can reset the unit to them whenever you need to.

When you store one or more User Types to the digital surround controller 
they become available in the list of Types, alongside the built-in Types. For 
more information about selecting one of the Types see Choosing a 
standard setting, page 50.

To name the  User Type

•   Click the Settings icon in the left-hand panel of the Meridian window:

 

•   Enter a suitable name in the Type name fi eld to identify your User Type, 
such as Standard.

The name can have up to 12 characters.

To create additional User Types

If you wish you can create several User Types, and store them all to the 
digital surround controller. You can then reset the digital surround 
controller to any of the User Types by selecting the appropriate Type name.

To create a new User Type:

•   Select the User Type you want to base it on in the left-hand panel of the 
Meridian Setup window; eg Standard.

•   Click the Copy as new user type button.
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The new User Type will be specifi ed as In use, as identifi ed by the
circle icon in the left-hand panel of the Meridian window:               

Initially the new type will be created with the same settings as the type you 
based it on, and with the name New type:

 

You can then change the name of the new Type, and confi gure its settings, 
in exactly the same way as for the original Type.

A suggested naming convention is to name User Types with the date they 
were created: for example, 06/05/98.

To   copy settings between User Types

•   Highlight the User Type you want to copy the settings from.

•   Choose Copy from the Edit menu, or click 
the Copy button in the toolbar:  

•   Highlight the User Type you want to copy the settings to.

•   Choose Paste from the Edit menu, or click the 
Paste button in the toolbar:  

You can also copy and paste source and preset settings from one section of 
a user type to the same section of another user type as follows:

•   Highlight the icon corresponding to the section of settings you want to 
copy: Sources, Presets, or Cards.

•   Choose Copy from the Edit menu, or click the 
Copy button in the toolbar: 
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•   Highlight the same icon in the User Type you want to copy to.

•   Choose Paste from the Edit menu, or click the 
Paste button in the toolbar:  
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Completing the configuration

The fi nal stage in creating a settings fi le is to save it, and then store it to 
the digital surround controller.

To save the current settings

•   Choose Save from the File menu or click the Save 
toolbar button, to save the changes you have made
to the settings fi le to your PC hard disk: 

To store the  settings to the digital surround controller

•   Click the Store button:  

The settings will then be downloaded
to the product, and the display shows:        Receiving Data...

As the download proceeds the following dialogue box shows its progress:

  

If the download was successful the product will briefl y display the owner 
name you have defi ned; 

For example:                                                  Zachary Ford

It will then switch itself to standby.

The User Type you have created will now be available in addition to the 
built-in Types, and will be selected by default if you need to reset the 
confi guration of the digital surround controller; see Choosing a standard 
setting, page 50.
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OffDSP MuteSourceReference Digital Surround Controller 861

Using Meridian  Room Correction

The 861 Reference Digital Surround Controller incorporates room 

correction, which takes advantage of advanced digital signal 

processing techniques to compensate for room artefacts, including 

resonances and refl ections, to give a signifi cant improvement in the 

sound, especially with non-ideal rooms.

This chapter explains how to run the Meridian  Room Correction 

program and use it to create profi les for use with the 861.
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Introduction

The Meridian Room Correction program works in conjunction with the 
Meridian Confi guration program to create a set of one or more room 
correction profi les matched to your room. These are then downloaded to 
the 861 and can be associated with particular presets, or selected from the 
front panel. Selecting a profi le applies a set of digital fi lters individually to 
each speaker to achieve the required room correction. 

If you use a single loudspeaker layout you may choose to have one room 
correction profi le, and use this with all presets. If you have separate 
speaker layouts for use with Music, Logic, and 5.1 Movie sources you will 
need to calculate a separate room correction profi le for each speaker 
layout. These will then be selected automatically by the 861 depending on 
the audio format. In addition, you can create separate room correction 
profi les to take account of changes to the room, such as the position of 
large items of furniture, or with curtains open or closed.

How   room correction profi les are calculated

Calculating a room correction profi le is a time-consuming and 
mathematically complicated process. Fortunately the Meridian Room 
Correction program performs the necessary sequence of measurements and 
calculations completely automatically, using a PC connected to the 861, 
with the minimum of interaction. It works as follows:

First you need to set up a microphone close to the listening position, and 
connect this to an appropriate input on the 861. Usually a standard sound 
pressure level meter will be used as a microphone; this can be the same one 
used for setting the speaker levels using the Calibration procedure. After 
an initial short test sequence, designed to check that the microphone is set 
up correctly, a series of test signals are presented to each loudspeaker and 
measured at the microphone to determine how the room response affects 
the sound from each speaker. This phase of the procedure takes about one 
minute per speaker, and can be left to run unattended. 

Finally after a complete set of measurements has been made for each 
channel and speaker layout, the program calculates a set of fi lters for each 
channel, and stores these to the 861. A copy of the measurements, 
together with the calculated fi lters in each profi le, is also stored on the PC 
so they can be accessed at a later date if required. All the room correction 
settings and measurements will be saved in a folder named after the MSF 
fi le. For example if your MSF fi le is called 861_theatre.msf then all of the 
room correction settings and measurements will be in a folder called 
861_theatre.mrd.
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Examples

Most domestic rooms tend to be rectangular, or at the very least have one 
pair of parallel facing walls, and unfortunately these are the ideal 
conditions for low frequency resonances within the room. The wavelength 
of low frequency sounds is relatively large, so even bookcases and curtains 
act as an almost perfect mirror for low frequencies. 

Frequencies close to the resonant frequency, determined by the distance 
between the two refl ective surfaces, will sound louder and take longer to 
decay than other frequencies. In practice this means that when listening to 
music some notes will sound louder, giving a roughness or unevenness to 
the sound.

Other problems that can be corrected by room correction are imbalances 
between the speakers due to positioning constraints. For example, in an 
L-shaped room one loudspeaker may need to be close to the wall whereas 
its partner is in an open area giving rise to an imbalanced sound fi eld. 

Unless your listening room has been specially designed for acoustic 
performance, you will almost certainly hear distinct benefi ts after 
incorporating room correction into your 861, and if the room has major 
resonances or imbalances the difference should be quite dramatic.

You can fi nd more information about the theory behind Meridian Room 
Correction on the Meridian Web Site at: 

http://www.meridian-audio.com/p_rc.htm
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  Auto set up 

This section explains how to create a basic room correction using default 
settings, download it to the 861, and select it for use with the DSP presets.

The Room Correction program is run from within the Meridian 
Confi guration program, and adds the room correction profi les to the 
current confi guration fi le.

Before running the room correction program

It is important that the MSF fi le within the Meridian Confi guration 
program exactly matches the settings in the 861 to which you want to add 
room correction profi les. To ensure this:

Either:

•   Fetch from the product, as described in To fetch the calibrated settings, 
page 93.

Or:

•   Store an 861 MSF fi le with your chosen settings to the product, as 
described in To store the settings to the digital surround controller, 
page 97.

If you have made changes to settings on the product (eg changed levels, 
phase or delay during the calibration phase or made a user-defi ned preset) 
since you last stored to the product, you should fetch from the product, or 
enter the changes manually in the MSF, before storing it to the product.

The room should be as you would normally use for listening. Close/open 
doors, close/open curtains, and position your screen and furniture as they 
would normally be for listening.
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To run the Room Correction program

•   Click the Room correction icon: 

The Room correction panel will be displayed:

•   Click the Launch Meridian Room Correction application button.

If necessary, you will fi rst be prompted to save the current confi guration. 
The Meridian Room Correction Set up wizard will then be displayed:

•   Click the Next button to continue.
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The next page allows you to specify which input card and analogue input 
you are going to use for the microphone or Sound Pressure Level meter, 
and the sensitivity of the input:

•   Select the appropriate card and input.

•   Specify the input sensitivity.

•   Click the Next button to continue.

•   Connect the SPL meter or microphone to the input you specifi ed, switch 
on the SPL meter and position it at the listening positioning.

When using an SPL meter the C weighting must be used, and the 90dB 
range is recommended, unless the loudspeakers measured less than 75dB 
SPL during the calibration in which case the 80dB range is recommended.

•   Click the Test mic button to run a test to check that the microphone is 
connected correctly:
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The following dialogue box will count down to the test:

A signal will then be played through the main left loudspeaker.

•   Check that the SPL meter reading does not indicate that the input signal 
is too large for the selected range.

On some meters this is indicated by the reading going above 0dB into the 
red range of the meter, and on others by the word high appearing on the 
display.

The Set up wizard will then indicate whether the test was successful:

If the test did not complete successfully check the SPL meter or microphone 
connections and the input card and connector settings and try again. For 
more information about problems with the microphone test see 
Troubleshooting, page 126.

•   Click the Next button to continue. 

The next screen lets you choose whether to do an automatic room 
optimisation, or create profi les manually.
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The Automatic option is recommended unless you are experienced in 
using the Meridian Room Correction program:

•   Select the appropriate option.

•   Click the Finish button to continue.

The following prompt then allows you to start the automatic room 
correction process:

•   Click the Start… button to begin. 

A countdown dialogue box will give you time to leave the room.

The Room Correction program will then present a test tone to each 
loudspeaker in turn for each of the distinct layouts defi ned in the 861 
Confi guration fi le: 



 USING MERIDIAN ROOM 
CORRECTION

107

Depending on the number of channels and layouts in your confi guration 
this may involve up to 24 tests and take up to 20 minutes to complete.

When the measurements have been completed the Build fi lters dialogue 
box will be displayed showing the fi lters being built for each channel and 
each speaker layout in turn:

Finally the calculated fi lters will automatically be stored to the 861.

The following dialogue box confi rms that the Auto set up has completed 
successfully:

•   Click the Close button to close the dialogue box.
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You will then be given the option of saving the settings:

•   Click the Yes button to save the settings and return to the Meridian 
Confi guration program. 

All the room correction settings and measurements will be saved in a folder 
named after the MSF fi le. For example if your MSF fi le is called 
861_theatre.msf then all of the room correction settings and 
measurements will be in a folder called 861_theatre.mrd.

The Room Correction panel will show the profi les calculated by the Set 
up wizard:

•   Store the settings from the Meridian Confi guration Program to the 861.

Each preset will be assigned the profi le designed for the layout used with 
the preset. The wizard creates profi les called Mus, Log, and Mov for the 
Music, Logic, and 5.1 Movie Speaker layouts respectively. If two or more 
layouts share the same settings, the profi le name will include all the layouts 
it applies to; eg MusLog or MusLogMov.

•   Quit from the Meridian Confi guration program.
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The following dialogue box will prompt you to save the settings and store 
them to the 861:

To change the room correction profi le from the front 
panel

•   Press < or > until the display shows the current profi le. 

For example:    CD    RC Bypassed

•   Press A or V to select the profi le you want to use.

For example:    CD    RC Mus

What next?

You have now completed the Auto set up, which creates a recommended 
set of room correction profi les. In most situations this is all you need to do 
in order to take advantage of room correction with your 861.

The next sections describe some of the more advanced options available in 
the Meridian Room Correction program, including the options for 
remeasuring channels, creating multiple profi les, selecting different fi lter 
parameters, and manually editing the fi lters.
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Viewing and repeating 
measurements

 The  Measurements panel shows a measurement for each of the speaker 
layouts set up in the 861 confi guration. You can also create additional 
measurements, such as to cater for different furniture layouts, and for each 
measurement you can view the effect of applying different profi les:

For each speaker layout the Measurements list shows a list of the 
channels to be measured, or All for all channels, with channels already 
measured shown in bold.

The Measurements panel gives you the option of viewing or comparing 
the measurements. You can also repeat the measurements for individual 
speakers, for example if an external noise interfered with the test 
procedure. 

To display the measurements

•   Run the Meridian Room Correction program.

•   When the Set up wizard is displayed click the Cancel button.

•   Click the Measurements tab.
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To view the measurements

•   Click with the right mouse button on the measurement you want to 
view and choose the appropriate channel from the View Measurement 
submenu on the pop-up menu:

The Plot measurement window allows you to see the measurement for 
the specifi ed channel:
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You can select one of the following three graph types from the Graph 
type pop-up menu. All three views of the measurment are calculated from 
the same measured test signal:

 Impulse response

Shows the response over time of the loudspeaker to a click. The curve 
shows a maximum just after time zero, and then decays rapidly depending 
on the amount of reverberation in the room. Any additional peaks in the 
response indicate resonances set up by the initial impulse.

 Low frequency response

Shows the loudspeaker-room response to a low frequency sine wave, swept 
between 0 and 250Hz. The ideal low frequency response would be smooth. 
A peak in the response indicates a resonance at the corresponding 
frequency. A dip in the response indicates absorption or cancellation at the 
corresponding frequency.
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Waterfall plot

Shows the response of the room to a series of short sine wave pulses of 
frequencies between 0 and 250Hz. It shows how the response decays over 
time at each of those frequencies.

The ideal waterfall plot would have a smooth profi le and decay evenly to a 
low level within 0.5 to 0.8 seconds. Peaks or dips in the waterfall plot 
indicate resonances or absorption at the corresponding frequency. Ridges 
extending forwards in time indicate reverberation at the corresponding 
frequency. 

The room correction profi le aims to identify the strongest resonances and 
to reduce the decay time of each strong resonance to the average decay 
time for the room.

To compare two measurements

The Plot measurement window allows you to display a particular graph 
type for two different profi les, or show the effect of one profi le compared 
to the original uncorrected room.

•   Choose the fi rst profi le to be compared from the Profi le menu, or 
choose Bypassed to display the uncorrected measurements for the 
channel.

•   Choose the second profi le to be compared from the Second graph 
menu.
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The two graphs will be displayed one above the other on the screen:

To change the axes

•   Click the Axes… button in the Plot measurement window.

The Set axes dialogue box allows you to set the range of the x, y, and z 
(waterfall plot only) axes:

•   Click the Update button to update the axes.
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To repeat measurements

You can repeat measurements for one or more channels; for example, if an 
external sound interfered with an existing measurement.

•   Click with the right mouse button on the measurement you want to 
repeat and choose Speakers… from the pop-up menu:

The following dialogue box allows you to select which channels you want 
to repeat:

•   Select the channels you want to repeat, or click the Toggle button to 
swap the set of selected channels.

•   Click the OK button to confi rm your selection.

The following dialogue box warns you that the existing measurements will 
be overwritten:

•   Click the Yes button to continue, or the No button to retain the existing 
measurements.

•   Click the Measure… button to measure the specifi ed channels.
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The following dialogue box then indicates how long the selected 
measurements will take, and gives you an opportunity to leave the room 
before the test sequence begins:

To create multiple measurements

To create a room correction profi le you need at least one measurement set 
for each of the speaker layouts defi ned in the confi guration fi le.

You can create additional measurement sets to take account of different 
confi gurations of the room, such as with curtains open or closed.

•   On the Measurements panel, click the Add button.

A new measurement set will be added to the list, with the default name 
measurement.

•   Click the Rename button to rename the measurement set.

•   Select the new measurement set and click the Measure… button to 
measure all the channels for each of the speaker layouts. 

To delete a measurement set

•   Select it in the Measurements list and click the Delete button.
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   Creating multiple profiles

After creating a measurement set you need to create a profi le for each of 
the speaker layouts in each of the measurement sets.

The Profi les panel shows a list of all the active profi les and allows you to 
create new profi les and build the fi lters for each profi le.

 To create a profi le for each layout

•   Click the Add button.

A new profi le will be added with the default name profi le.

•   Select the speaker layout from the Layout type list:

•   Repeat to create profi les for each of the other layouts.
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  To build the fi lters for a profi le

•   Select the profi le in the Active profi les list and click the Build fi lters… 
button.

The Build fi lters dialogue box is displayed to allow you to specify the 
target decay time:

By default a target decay time is automatically calculated for the layout, 
but you can specify a value manually if you prefer, as follows:

•   Select Manual and enter the decay time, in milliseconds, in the fi eld. 

Choosing a shorter decay time will lead to a profi le with more fi lters, and 
fi lters which are deeper, which will take more bass out of the signal. 
Typically a decay time of 350 milliseconds is appropriate for domestic 
listening, and 200 milliseconds gives a dryer reverberation suitable for a 
studio.

•   Click the Build fi lters button to start building the fi lters.
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If you have more than one measurement set the following dialogue box is 
displayed to allow you to select which measurement set you want to use 
for the fi lters:

Note: The process of building fi lters is computationally intensive, and it is 
recommended that you do not try to run other programs at the same time.

As the fi lters are calculated the response will be displayed in the lower half 
of the dialogue box. When the fi lters have been completed, the status of 
each fi lter will be shown as Complete, and you can click on it to display 
the response:

•   Click the OK button to close the Build fi lters dialogue box.
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After building fi lters for a profi le the Active profi les list shows the 
number of fi lters used for the profi le, and the number of remaining fi lters 
available: 

Each profi le can use up to 60 fi lters; if a profi le requires more fi lters than 
this, fi lters will be allocated in order of priority.

Each channel is limited to a maximum of 20 fi lters; a two-channel system 
therefore has a limit of 40 fi lters.

To store profi les temporarily to the 861

You can store profi les temporarily to the 861 so you can listen to them 
while using the Meridian Room Correction program.

•   Click the Store… button.

The following dialog box confi rms that the profi les have been stored:

•   Click the OK button to continue.
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  Editing  filters

After building the fi lters for a profi le you can edit the fi lters numerically or 
graphically to adjust their parameters, or change the response of each 
fi lter. 

Note: This should only be attempted by users with an understanding of 
fi lter design. It is strongly recommended that you copy the profi le fi rst and 
then edit the copied profi le. There is no undo function within Edit fi lters.

 To display the fi lters for a profi le

•   Select the profi le in the Active profi les list.

•   Click the Edit fi lters… button.

The following dialogue box shows a list of the channels, and a list of the 
fi lters for each channel, together with the parameters for each fi lter:

•   Select the channel in the Channel list to display the fi lters for that 
channel.

The columns give the fi lter number, centre frequency (Hz), gain (dB), and 
fi lter bandwidth (Hz), and you can adjust these parameters for each fi lter.

In addition, the list of fi lters shows the Room mode bandwidth (Hz), 
Equalized bandwidth (Hz), RT60 (s), and Target RT60 (s). 

To edit a fi lter numerically

•   Select the fi lter in the Filters list.

•   Adjust the frequency, gain, and width in the fi elds below the Filters list.
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To edit the fi lters graphically

•   Click the Graphical tab to display the Graphical panel in the Edit 
Filters dialogue box.

•   Select the channel in the Channel list to display the fi lters for that 
channel in the Filter response graph:

•   Select the fi lter you want to edit by clicking on the square above the 
fi lter trough:

Alternatively if the fi lters are close together you can select a specifi c fi lter 
using the Filter fi eld below the Filter response curve.
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The fi lter will be displayed with a red vertical bar at the fi lter centre 
frequency, and a rectangle indicating the bandwidth of the fi lter:

To adjust the centre frequency of the fi lter:

•   Drag the fi lter rectangle to the left or right on the fi lter response curve.

To adjust the gain or bandwidth of the fi lter:

•   Resize the fi lter rectangle by dragging one of the handles at the bottom 
corner of the fi lter:

To add a fi lter

•    Click the Add button on the Numerical or Graphical panel.

•   Edit the parameters of the fi lter in the Freq, Gain, and Width fi elds, or 
graphically.

To delete a fi lter

•   Select the fi lter you want to delete in the Filters list, or on the 
Graphical panel. 

•   Click the Delete button.
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 Changing settings at a later date 

This section describes how to change the room correction or confi guration 
settings of the digital surround controller at a later date, subsequent to 
uploading the original version to the 861.

Note: You can only edit or add to existing profi les if you have the MSF fi le 
and mrd folder originally used to design the profi le. If you do not have the 
original MSF fi le and mrd folder you will need to make new measurements, 
create new profi les, and then store these to the 861.

To edit an existing profi le, or add a new profi le

•   Run the Meridian Confi guration Program and open the MSF fi le used to 
create the original profi les.

If you have changed settings on the 861 since the original profi les were 
made, and you want to retain these changes:

•   On the File menu, click Save as to save the MSF fi le under a new name.

This will also create a renamed copy of the mrd folder containing the 
original measurements and profi les.

•   On the File menu, click Fetch from products to fetch the settings from 
the 861.

•   Run the Meridian Room Correction program.

•   When the Set up wizard is displayed click the Cancel button.

•   Select the Profi le tab, and proceed as described in Editing fi lters, page 
121, or Creating multiple profi les, page 117.

To change other settings if you have the original MSF 
fi le and mrd folder

•   Run the Meridian Confi guration Program and open the original MSF fi le.

If you want to keep the original settings:

•   On the File menu, click Save as to save a copy of the MSF fi le and mrd 
folder under a new name.

•   Change the settings as required and store the new settings to the 861.
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For more information about changing confi guration settings using the 
Meridian Confi guration Program refer to the chapter Confi guring the 
digital surround controller with a computer, page 65.

To change other settings if you have lost the original 
MSF fi le and mrd folder

If the original MSF fi le and mrd folder are not available you will be able to 
change all non-room correction settings, and which room correction profi le 
you want to use with a given preset.

•   On the File menu, click Fetch from products to fetch the settings from 
the 861.

A new MSF will be created. This will contain the profi le labels and these 
can be used to chose the profi le you want to use with a given preset. It will 
not contain measurements or profi le data for the Meridian Room 
Correction program. If you use the Meridian Room Correction program to 
create new measurements and profi les and store these to the 861, the old 
profi les will be overwritten.

•   Change the settings as required and store the new settings to the 861.

For more information about changing confi guration settings using the 
Meridian Confi guration Program refer to the chapter Confi guring the 
digital surround controller with a computer, page 65.

To change other settings directly on the 861

For information about changing other confi guration settings on the 861 
refer to the chapter Confi guring the digital surround controller without a 
computer, page 49.

After making changes on the 861 you can add these changes to an existing 
MSF fi le as follows:

•   Run the Meridian Confi guration Program and open the original MSF fi le.

•   On the File menu, click Fetch from products to fetch the new settings 
from the 861.

If you want to keep the original settings:

•   On the File menu, click Save as to save a copy of the MSF fi le and mrd 
folder under a new name.

This will also create a renamed copy of the mrd folder containing the 
original measurements and profi les.
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  Troubleshooting

This section gives suggested solutions to typical problems that may occur 
when using the Meridian Room Correction program. If problems still persist 
after working through the following steps please send an email to 
support@meridian.co.uk with a zip fi le containing your MSF fi le and all the 
fi les in the associated mrd folder and its subfolders. For example if your 
MSF fi le is called 861_theatre.msf then please send a zip archive 
containing this fi le together with all fi les in the 861_theatre.mrd folder 
and its subfolders. Please also supply details of the loudspeakers and 
amplifi ers you are using.

Failed microphone/SPL meter test

During the microphone/SPL meter test details are displayed in the 
following dialogue box:

The pass/fail status of the microphone measurement is based on the Power 
and SNR (signal to noise ratio) values. In most rooms and with most SPL 
meters Power will usually be in the range –25 to –35, and SNR will usually 
be in the range 44 to 60. The larger the SNR the better the measurement. 

The following sections describe some of the most likely problems which will 
cause the Power and SNR values to go outside these ranges.
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Power less than –44

The following error will be displayed:

This indicates that there is very little or no signal on the connector you 
have chosen as your microphone input. Check the following:

• That there was sound from front left speaker during the test.

If in doubt, repeat the microphone/SPL meter test. If there is still no sound 
check the connections from the 861 to the left loudspeaker. Switch the 861 
off and then on again, select Calibrate as described in Calibrating the 
system, page 53, and check that the left speaker plays the calibrate signal.

• The lead from the SPL meter is intact.
• The SPL meter is switched on and set to the 90dB band, or the band 

which includes 90dB, and with C weighting.

If the loudspeakers measured less than 75dB SPL during the calibration 
phase it may better to use the 80dB range.

• The lead from the SPL meter is connected to the connector you have 
chosen in the program.

The connector chosen for a microphone input will always be the left 
channel of a stereo input, and the left, centre, or rear left channel of a 
multi-channel input.

• The Sensitivity setting is adequate for the SPL meter or microphone.

The sensitivity value for the 861 analogue input cards is given in rms volts 
(Vrms). For example a sensitivity of 1Vrms allows a signal of 2.8Vpp. A 
sensitivity of 1V is recommended for use with most SPL meters though 0.5V 
may be preferable for those with lower level output.
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Power OK, SNR less than 18

The following error will be displayed:

The most likely cause of this problem is that an analogue source is 
connected to the input chosen for the microphone. 

• Check that the lead from the SPL meter is connected to the input you 
have chosen for the microphone test. 

Another possibility is that the lead from the SPL meter is in bad condition 
and only making a poor connection.

Power OK, SNR between 18 and 34

The following error will be displayed:

The reasons for this are described in detail in the following section where 
example measurements are also shown.
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Repeated measurements due to poor SNR

Measurements are retried until the SNR is larger than 43 or the maximum 
number of retries have been made. The maximum number of times each 
measurement will be retried due to poor SNR can be set in the 
Preferences dialogue box, accessed from the Options menu:

The default number of retries is 3. If the measurements are consistently 
giving poor SNR fi gures you can reduce the number of retries. However, it 
is better to follow the steps described below to improve the measurement 
conditions. The better the measurement the more accurate the results 
when calculating the fi lters for a profi le.

SPL meter is set on a low band

The following graph shows an impulse response obtained when a Radio 
Shack SPL meter was set on the 60dB band. The SNR value was only 22:
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SPL meter is set on a high band

The following graph shows an impulse response obtained when a Radio 
Shack SPL meter was set on the 120dB band. The tail of the response is 
generally noisy. The SNR value was 39 but the Power was only –48:

Loudspeaker is running in a non-linear range

The effects of a loudspeaker running in a non-linear range is most easily 
observed in the impulse response. The tail of the response has small spikes, 
as shown in the plot below, where it should be zero. The larger these spikes 
are relative to the largest value at the beginning of the impulse response 
the smaller the SNR value.

Check the following:

• That the bass protection size has been correctly set – use the procedure 
described in Speaker size, page 58, to do this.

• That the bass drive unit in your loudspeaker is not rubbing.
• That your amplifi er is not clipping.
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If problems are still encountered, use the phase/gain tab under speaker 
layout to reduce the gain of the channel. Use the reduced gain setting for 
the room correction measurements, then return to the correct level for a 
calibrated system after running room correction measurements.

Hum in the system

The effect of hum on the measurement is most easily observed in the 
waterfall plot. The continuing signal at 50Hz and 150Hz in the waterfall 
plot shown below indicates a mains hum loop:

You are likely to have heard this level of hum when playing analogue 
sources connected to the same analogue input card as the microphone/SPL 
meter. 

In order to get a better measurement disconnect analogue sources from 
the analogue input card used for the room correction measurements. In 
order to improve your overall system reorganise wiring to remove the hum 
loop. 

Hum may also be picked up by the lead from the microphone/SPL meter. It 
is best to use a shielded cable to reduce the chances of picking up hum.
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Absolute phase

A control which changes the phase of the signals to all the speakers.

AC-3

An alternative name for the Dolby Digital format.

Ambisonic

A music encoding and decoding system designed to re-create the original 
soundfi eld using an array of loudspeakers.

Aspect ratio

The overall shape of the speaker layout.

Compress

A DSP parameter providing dynamic range control for Dolby Digital 
sources.

Controller

The product in a Meridian system that uses the infra-red signals from the 
remote to control the system. The controller is normally chosen 
automatically, but the installer can override this.

Dolby Digital

A digital surround-sound which provides fi ve full-frequency range channels 
(left, centre, right, left surround, and right surround) and an additional 
Low Frequency Effects (LFE) channel which is band limited to 120Hz.

Dolby Surround

The encoding system used for the majority of movies on video and many TV 
broadcasts. Dolby Surround encoded material can be replayed with a 
surround decoder connected to an array of loudspeakers which normally 
include at least left, centre, right, and rear surround.

DTS

Digital Theatre Systems originally produced digital audio tracks for motion 
pictures. A version of this format adapted for consumer video and audio 
products is referred to as DTS Entertainment. Like Dolby Digital it provides 
fi ve full-frequency range channels (left, centre, right, left surround, and 
right surround) and an additional Low Frequency Effects (LFE) channel.
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DVD

Digital Video Disc or Digital Versatile Disc, a versatile CD-sized disc with 
nearly 30 times the storage capacity of CD. It is capable of storing digital 
video, high-quality multi-channel audio, or computer data.

DVD-Audio

A DVD disc containing audio tracks in one or more of a number of 
alternative formats to provide higher quality or higher capacity than CD, 
multi-channel audio, together with the option of still images or video. A 
DVD-Audio disc may also include lower quality versions of the material in 
DVD-Video format for compatibility with players that do not support DVD-
Audio.

DVD-Video

A DVD containing video tracks together with one or more soundtracks, 
menus, and other entertainment features.

Layout

Refers to a particular arrangement of speakers and subwoofers. You can 
select different layouts for the Logic, Music, and 5.1 Movie DSP presets.

LFE

The Low Frequency Effects (LFE) channel which enhances movie 
soundtracks with sound effects and ambient sounds. It is band limited to 
120Hz in a Dolby Digital system.

LFE sub

A subwoofer which, in addition to any bass which it handles from the main 
channels, plays the full 120Hz bandwidth LFE signal in Dolby Digital, DTS, 
and MPEG presets.

Limit

A DSP parameter that sets the peak-level limit of the bass signal added to 
the main loudspeakers.

Menus

The fl exible system for choosing options and confi guring settings in 
Meridian products. On the 861 the menus are controlled by the <, >, A, 
and V keys under the front panel or on the MSR.
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MHR

Meridian High Resolution is a proprietary secure encoding format using 
encryption and anti-copy methods that allows secure transfer of audio 
streams between elements of a Meridian-only system for the purpose of 
playback only. It provides a secure copyright protection environment and 
has the very important benefi t of lowering jitter and improving sound 
quality on all material.

MLP

MLP (Meridian Lossless Packing) is an audio format that increases the 
amount of information that can be recorded on a CD or DVD, without any 
loss of quality.

Mono sub

A subwoofer which handles all the bass for the system. A THX standard 
subwoofer has a crossover at 80Hz.

Mono surrounds

Surrounds which have a common signal steered to them. This may then be 
decorrelated by the THX process to give more spaciousness.

MPEG

MPEG Surround is a digital encoding system developed by the Motion 
Picture Expert Group. Like Dolby Digital it provides fi ve full-frequency 
range channels and an additional Low Frequency Effects (LFE) channel.

MSF

Meridian Settings File, a fi le containing settings and User Types for one or 
more Meridian products.

MSR

The Meridian System Remote, or handset.

OSD

On-screen display, which the 861 can superimpose on a composite video 
signal to give information about the state of the system, and to help 
during confi guration.

PCM

Pulse Code Modulation, the method used to encode music digitally, as used 
on audio CDs.
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Preset

A DSP decoding option in the 861. You can create user-defi ned presets 
based on the built-in presets, and with specifi c parameter values; see 
Defi ning your own presets, page 35.

Profi le

A set of fi lters designed using the Meridian Room Correction program to 
improve the loudspeaker-room interface.

RT60

The time taken for a signal to decay by 60dB.

SNR

Signal to noise ratio, an indication of the quality of a signal or 
measurement. The larger the SNR the better the quality.

Source

An input to the system, such as CD or TV. The Meridian 500 and 800 Series 
provide 12 named sources, corresponding to the names of the 12 source 
keys on the MSR. In the 861 you can choose the logo displayed for each 
source, and the input used for it.

SPL

Sound Pressure Level, a physical measurement of the level of sound at a 
particular location which can be obtained using an SPL meter.

Steered surrounds

Surrounds which have individual signals steered to them by the digital 
surround controller’s steering matrix.

Surround

A sound reproducing system with more than two loudspeakers, and usually 
with speakers behind or to the side of the listener.

THX

Additional processing that follows Dolby Pro Logic Surround decoding to 
give a more faithful reproduction of cinema sound in the home.

Trifi eld

A music decoding system designed to extract centre and surround signals 
from a conventional 2-channel stereo source.
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Type

A standard confi guration of the digital surround controller. Selecting a 
Type resets any confi guration and calibration changes to either a factory 
default, or a stored set of user settings.
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A

AC-3  3
Academy (DSP parameter)  43
accessories, Tape card  21
Advanced setup options  91
Ambisonics (DSP preset)  39,46
analogue sources, adjusting 
sensitivity  60
audio connections, setting up using 
a PC  79
Auto set up  102
axis, changing  29
Axis (DSP parameter)  26

B

Balance (DSP parameter)  26, 29
bass, changing  28
Bass (DSP parameter)  26, 28
brightness, display  18
Bright (DSP parameter)  25
built-in presets, replacing  35

C

calibration procedure  49, 53
exiting  54
starting  53
calibration tests  55
Distance  56
Fine tuning  57
Levels  55
Speaker size  58
cards, setting up using a PC  88
Cards icon  66
Centre (DSP parameter)  26, 31, 39
centre speaker
changing the relative delay  31
changing the relative level  31
Channels (DSP parameter)  40
Cinema (DSP preset)  44
clip indicator  61
compression  46
Compress (DSP parameter)  46

confi guration
resetting  50
without a computer  49
Confi guration program  66
installation  67
requirements  67
running  68
toolbar buttons  68
content types  17, 19, 79
Movie 2  17
Movie 6  17
Music 2  17
Music 6  17
contrast, display  18
Contrast (DSP parameter)  25
copying settings between user 
types  95
crossover frequency, adjusting  61

D

Depth (DSP parameter)  26, 31
diagnostic displays  91
Dialog Normalisation  47
digital audio formats
AC-3  3
Dolby Digital  3
DTS  3
MPEG Surround  3
Digital Signal Processing  2
Dimension (DSP parameter)  41
Direct (DSP preset)  41
Discrete (DSP preset)  44
display
brightness  18
contrast  18
information  19
on-screen  19
Distance (calibration test)  56, 57
Dolby Digital DSP preset, dynamic 
range control  46
Dolby Digital encoding  3
DSP  2

Index
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DSP parameters
changing  25, 26
standard  26
DSP presets  3, 37
Ambisonics  39, 46
assigning to a source  34
changing  17
Cinema  44
clearing  36
confi guring using a PC  83, 88
defi ning  35
Direct  41
Discrete  44
Dolby Digital  3
DTS  3
editing name  35
EX  45
EZ  45
modifying a built-in preset using a PC  84
Mono  43
MPEG  3
Music  38
MusicLogic  40
PLII Movie  42
PLII Music  40
PLII THX  42
selecting  17
Stereo  41
Super  40
THX  45
THX EX  45
THX Music  45
THX Ultra2  45
Trifi eld  38
TV Logic  43
user-defi ning  36
DTS encoding  3
dynamic range control  46

E

EX (DSP preset)  45
EZ (DSP preset)  45

F

fetching calibrated settings  93
fi lters, editing  121

5.1 Movie DSP presets  44
Compress parameter  46
5.1 Music DSP presets  44
front panel keys  12

G

Gain/Sub mode  60
glossary  133

H

headphone volume  21
HS Out? (DSP parameter)  26

I

impulse response  112
Input (DSP parameter)  43

L

layouts  6,73
5.1 Movie  44
Logic  42
Music  38
Levels (calibration test)  55
LFE (DSP parameter)  45, 46
LipSync (DSP parameter)  26, 33
lip sync  33
listening position, changing  29
locking the menus  24
Logic DSP presets  42
loudspeakers
setting up using a PC  73
specifying layout using a PC  73
specifying the sizes using a PC  75
low frequency response  112

M

Measurements panel  110
menus, locking  24
Meridian Confi guration program.
See confi guration program
Meridian High Resolution (MHR)  91
Meridian Room Correction. See room 
correction
Meridian Room Correction program. 
See Room Correction program
Meridian System Remote  13
Mix level  47
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Mono (DSP preset)  43
Mono Rear (DSP parameter)  40, 43
Movie 2  17, 79
Movie 6  17, 79
MPEG Surround encoding  3
multi-channel link  7
MusicLogic (DSP preset)  40
Music (DSP preset)  38
Music 2  17, 79
Music 6  17, 79
Music DSP presets  38
muting the sound  16

O

on-screen display  19
position  19, 33
Options (View menu)  69
Options dialogue box  69
OSD (DSP parameter)  25, 33
Owner icon  71

P

Panorama (DSP parameter)  41
Party? (DSP parameter)  43
peak-level limiting  76
personal details, entering using 
a PC  71
phase, changing  28
Phase (calibration test)  57
Phase (DSP parameter)  25, 26, 28
PLII (DSP preset)  42
PLII Movie (DSP preset)  42
PLII Music (DSP preset)  40
PLII THX (DSP preset)  42
Position (DSP parameter)  40
presets
confi guring  84
defi ning  35
deleting user-defi ned  87
modifying  84
user-defi ned  36,86
Presets icon  66,83
profi les, creating  117
Pro Logic (DSP parameter)  42

R

Rear (DSP parameter)  26, 30
rear speakers
changing the relative delay  32
changing the relative level  30
recording  21
remote  13
resetting the confi guration  50
return to top level icon  71
Roll (DSP parameter)  40, 43
room correction  99
room correction profi les  100
changing from front panel  109
choosing for a preset  85
creating  117
fi lters  118, 121
Room Correction program  99
auto set up  102
changing settings  124
fi lters  118,121
measurements  110
profi les  100,117
troubleshooting  126
R Delay (DSP parameter)  26, 32, 41
R Filter (DSP parameter)  39, 40, 45

S

Save As (File menu)  70
selecting a source  15
serial cable, connecting  69
serial port, specifying  69
settings fi le
creating  70
printing  92
saving  92
storing  92,97
Settings icon  71, 72
Setup icon  66, 90
Setup options  90
advanced  91
Sides (DSP parameter)  26, 30
side speakers
changing the relative delay  32
changing the relative level  30
sinewave sweep test  62
SizeCalc  76



142

Sound Pressure Level meter  53
sources  15
adjusting sensitivity of analogue  60
advanced options  82
assigning DSP presets  34
confi guring options using a PC  78
default DSP preset  17
recording  21
selecting  15
setting advanced options using a PC  81
setting up  60
setting up using a PC  77
specifying connections using a PC  79
Sources icon  66, 78
spaciousness of the sound, 
changing  32
speakers
specifying layout using a PC  73
specifying sizes using a PC  75
Speakers icon  66
specifi cation  9
standard DSP parameters  26
standard settings, selecting  50
standby, switching to  14
Steered All (DSP 
parameter)  40, 41, 42, 43
Steering (DSP parameter)  46
Stereo (DSP preset)  41
subwoofers, crossover frequency  61
Super (DSP preset)  40
Surr. Rear (DSP parameter)  39, 45
switching on and off  14
S Delay (DSP parameter)  26, 32, 41
S Filter (DSP parameter)  39, 40, 45

T

Tape card  21
television, recording from  21
THX (DSP preset)  45

THX EX (DSP preset)  45
THX level  55
THX Music (DSP preset)  45
THX Ultra2 (DSP preset)  45
time-aligning the system  56
toolbar buttons  68
treble, changing  28
Treble (DSP parameter)  26,2 8
Trifi eld (DSP preset)  38
TV Logic (DSP preset)  43
2+2+2 (DSP parameters)  45
Types  50

U

UHJ format  39
unlocking the menus  24
user-defi ned presets  35
clearing  36
creating  86
editing name  35
User Types
copying settings between  95
creating  94
naming  94

V

video connections, setting up using 
a PC  81
volume
adjusting  16
headphone  21

W

waterfall plot  113
Width (DSP parameter)  39, 40, 41

Y

Yaw (DSP parameter)  40, 43


